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MIKE 11
1 PREFACE
1.1 Copyright |

1.2

1.3

This document refers to proprietary computer software which is protected by copyright. All rights
are reserved. Copying or other reproduction of this manual or the related programs is prohibited
without prior written consent of DHI Water & Environment (DHI). For details please refer to your
'DHI Software Licence Agreement.

Limited Liability

The liability of DHI is [imited as specified in Section III of your 'DHI Software Licence Agreemcnt':
'IN NO EVENT SHALL DHI OR ITS REPRESENTA-TIVES (AGENTS AND SUPPLIERS)
BE LIABLE FOR ANY DAMAGES WHATSOEVER INCLUDING, WITHOUT
LIMITATION, SPECIAL, INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES
OR DAMAGES FOR LOSS OF BUSINESS PROFITS OR SAVINGS, BUSINESS
INTERRUPTION, LOSS OF BUSINESS INFORMATION OR OTHER PECUNIARY LOSS
ARISING OUT OF THE USE OF OR THE INABILITY TO USE THIS DHI SOFTWARE
PRODUCT, EVEN IF DHI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. THIS LIMITATION SHALL APPLY TO CLAIMS OF PERSONAL INJURY TO

THE EXTENT PERMITTED BY LAW. SOME COUNTRIES OR STATES DO NOT ALLOW

THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL, SPECIAL,
INDIRECT, INCIDENTAL DAMAGES AND, ACCORDINGLY, SOME PORTIONS OF
THESE LIMITATIONS MAY NOT APPLY TO YOU. BY YOUR OPEN ING OF THIS
SEALED PACKAGE OR INSTALLING OR USING THE SOFTWARE, YOU HAVE
ACCEPTED THAT THE ABOVE LIMITATIONS OR THE MAXIMUM LEGALLY
APPLICABLE SUBSET OF THESE LIMITATIONS APPLY TO YOUR PURCHASE OF THIS
SOFTWARE. : . :

About MIKE 11 and the present Manual

MIKE 11, developed by DHI Water & Environment, is a software package for simulating flows,
water quality and sediment transport in estuaries, rivers, irrigation channels and other water bodies.

This manual provides a short description of MIKE 11 and in particular MIKE 11 with emphasis on
the basic features and usage of the fully Windows integrated Graphical User Interface of MIKE 11.

_ Additionally, a tutorial is described with the aim of introducing MIKE 11 to users with no or very

little experience with MIKE 11 and guide them through the set-up and simulation of a simple river
system.

Presentation of results from MIKE 11 is carried out with MIKE View. MIKE View is a Windows
based result presentation and reporting tool for both MIKE 11 and MOUSE (MOUSE, developed
by DHI, is a software package for simulating surface runoff, flows, water quality and sediment

_ transport in urban catchments and sewer systems). A tutorial is described in order to familiarise

MIKE 11 users with the features and usage of MIKE View. More detailed description of MIKE
View is supplied in a separate MIKE View manual.

DHI Water & Environment  1-1
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MIKE 11

The MIKE 11 User Guide and MIKE 11 Reference Manual complements the present manual and
the online Help with essential information on conceptual and algorithmic implementation of the
main processes treated by MIKE 11, as well as descriptions of applied modelling techniques.

To help you to learn using MIKE 11 efficiently, the online Help and the present manual can be used
to guide you through the facilives of MIKE 11.

-1-2 DHI Water & Environment
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BEFORE YOU BEGIN

Product Support

If you have questions concerning MIKE 11 or problems with the MIKE 11 software, please consult
the present manual, the MIKE 11 User Guide, MIKE 11 Reference Manual or the online Help.
Additional release notes will be made available and can be found in the README file contained on
your latest update disks sent with your installation

If you have access to the Internet, You may also have a look under ‘Frequently Asked Questions’
(FAQ) or Reported Problems and Workarounds’ on the MIKE 11 Home Page.

The MIKE 11 Home Page is located at
‘http:/ /www.dhi.dk/MIKE 11

If you cannot find the answer to your queries, please contact your'local agent.

In countries where no local agent is present you may contact DHI directly, by mail, phone, fax or e-
mail:

DHI - Water & Environment

Agem Allé 11

2970 Horsholm

Denmark

Phone: +4545169200

Telefax: +45 45169292
"e-mail:  Software(@dhi.dk

Internet: http://www.dhi.dk

If you wish to upgrade or purchase additional mbdules on an existing installaton, please contact
your local agent or DHI.

The most efficient way of communicating is by e-mail, allowing us to optimise services to our
clients. Under normal circumstances, all e-mail messages received at DHI will be answered within 24
hours.

When contacting your local agent or DHI, you should have the following information at the ready:

The version number of your MIKE 11 installation.

The exact wording of any message that appears on the monitor (in case of software problems).
A description of what happened and what you were trying to do when the problem occurred.

A description of how (if at all) you tried to solve the problem.

The type of hardware you are using including available memory.

DHi Water & Environment
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2.2

2.3

2-2 DHI Water & Environment

DHI Trafning Course

DHI software is often used to solve complex and complicated problems, which requires a good
perception of modelling techniques and the capabilities of the software.

Therefore DHI provides training courses in the use of our products. A list of standard courses is
offered to our clients, ranging from introduction courses to courses for more advanced users. The
courses are advertised via DHI Software News and our home page on the Internet.

We can adapt training courses to very specific subjects and personal wishes. We can also assist you
in your effort to build models applying the MIKE 11 software.

If you have any questions regarding DHI training courses do not hesitate to contact us.

Comments and Suggestions

Success in perception of the information presented in this document, together with the user's
general knowledge of river systems, hydrology, hydrodynamics and experience in numerical
modelling is essential for getting 2 maximum benefit from MIKE 11. This implies that the quality of
the documentation, in terms of presentation style, completeness and scientific competence,
constitutes an important aspect of the software product quality. DHI will, therefore, appreciate any
suggestion in that respect, hoping that future editions will contribute to the improved overall quality
of MIKE 11. : .

Please give your contribution via e-mail, fax or letter.
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WELCOME TO MIKE 11

3.1 Introduction
Welcome to MIKE 11.

The release of MIKE 11 version 4 (back in 1997) started 2 new era for the most widely applied
dynamic modelling tool for rivers and channels. MIKE 11 is part of the new generation of DHI
software based on the MIKE Zero concept, comprising a fully Windows integrated Graphical User
Interface, which conforms to the evolving standards for Windows based software. However, the
well-known and well-tested computational core of the previous MIKE 11 generation - the ‘Classic’
version - remains. MIKE 11 is a true 32-bit application securing fast computational speed or
number crunching in comparison with earlier MIKE 11 versions.

By applying MIKE 11 it is possible to answer questions such as:
what are the exceedance levels in case of flooding — and at which locations will flooding occur?
what are the implications of introducing e.g. flood control measures? '

the long-term environmental impact affected by changing pollution loadings?

ents deposited in the rver system - and what are the overall morphological

what is
where are sedim

changes?
e what are peak concentrations of pollutants at specific locatons after e.g. heavy polluted loadings

from Urban catchments, CSO’s (combined sewer overflow) or industry plants?

And much more... :

3.2 Short Description of MIKE 11

g software package for the simulation of flows, water quality

MIKE 11 is a professional engineerin,
other water bodies.

and sediment transport in estuaries, rivers, irrigation systems, channels and

MIKE 11isa user-friendly, fully dynamic, one-dimensional modelling tool for the detailed analysis,
design, management and operation of both simple and complex river and channel systems. With its
exceptional flexibility, speed and user friendly environment, MIKE 11 provides a complete and
effective design environment for engineering, water resources, water quality management and
planning applications. ' . ‘ !
The Hydrodynamic (HD) module is the nucleus of the MIKE 11 modelling system and forms the ’
Advection-Dispersion, Water Quality and ‘i'l

basis for most modules including Flood Forecasting,
Non-cohesive sediment transport modules. The MIKE 11 HD module solves the vertically :

integrated equations for the conservation of continuity and momentum, i.e. the Saint Venant

equations.

Applications related to the MIKE 11 HD module include:
e Flood forecasting and reservoir operation
e Simulation of flood control measures

DHI Water & Environment 3-1



¢ Operation of irrigation and surface drainage systems
® Design of channel systems
¢ Tidal and storm surge studies in rivers and estuaries

The primary feature of the MIKE 11 modelling system is the integrated modular structure with 2
variety of add-on modules each simulating phenomenon related to river systems.
In addition to the HD module descrbed above, MIKE 11 includes add-on modules for:
e Hydrology ‘
Advection-Dispersion
Models for various aspects of Water Quahty
Cohesive sediment transport
Non-cohesive sediment transport

MIKE 11

MIKE 11 has long been known as a software tool with advanced interface facilities, for the benefit
of easy applications. Since the beginning MIKE 11 was operated through an efficient interactive
menu system with systematic layouts and sequencing of menus. At each stage within the menu tree,
an on-line support was provided by relevant Help menu screens. It is within than framework where
the latest ‘Classic’ version of MIKE 11 — version 3.20 was developed. '

The new generation of MIKE 11 combines the feamres and experiences from the MIKE 11 *Classic’
period, with the powerful Windows based user interface including graphical editing facilities and
improved computational speed gained by the full utilisation of 32-bit technology.

On the input/edit side MIKE 11 features:
graphical data input/editing
simultaneously input/editing of various data types
copy & paste facility for direct import (export) from e.g. spreadsheet programs
fully integrated tabular and graphical windows
importing of river network and topography data from ASCII text files
user defined layout of all graphical views (eolours,' font settings, lines, marker types etc.)

*On the Output side, advanced presentation facilities are available, including:
¢ coloured horizontal plan graphics for the system data and results
animated presentation of results in horizontal, longitudinal and time series plot
synchronised animation of results -
presentation of external time series
copy & paste facility for exporting result tables or the presentation graphics into other
applications (spreadsheet, word processing or others)

What’s New

Every new release of MIKE 11 comprises new modules, new features and/or corrections to
problems or significant 1 inconsistencies discovered in previous releases. A description of new
features etc. can be found in a README file on the DHI CD-ROM. -

DHI Water & Environment
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'GETTING STARTED

Hardware Requirements

The new generation of MIKE 11 is based on a fully Windows integrated Graphical User Interface
and is compiled as a true 32-bit application. This implies that MIKE 11 can only be executed under
Windows 95/98/2000 or Windows NT.

The hardware requirement_s for executing MIKE 11 (and later versions) are therefore similar to
those recommended for utilising Windows 95/98 or Windows NT. These are:
Minimum: Recommended:

Processor: Pentium, 90 MHz  Pentium, 200 MHz (or more)

Memory (RAM): 32Mb - 64 Mb (or more)

Hard disk: 100 Mb 1 Gb (or more)

Monitor: o - SVGA . SVGA, resolution 1024x768

Memory on Graphic card ' _ 1 Mb Ram (or more)

CD-Rom drive: 2 x Speed 10 x Speed {or more)

Installation of MIKE 11

To install MIKE 11 1nsert the DHI CD-ROM into the CD-Rom drive on your PC with the
llustrated surface placed upwards.

Activate the Windows Explorer and double-click the CD-Rom drive (typically D:\ or E:\). Change
directory to ‘MIKEZero Products’ by double-clicking the folders on the CD-Rom and run
‘Setup.Exe’.

The Set-up program automatically installs all niecessary MIKE 11 files and folders to your PC.
Additionally, a ‘MIKE 11’ group is created, containing icons for MIKE 11, MIKE 11 Convert,
MIKE View, MIKE Print and the Image Rectfier.

How to start MIKE 11
To start MIKE 11 select the ‘MIKE 11’ icon under the ‘MIKE 11’ group.

Starting MIKE 11 without a DHI configured Software Key and a valid licence file, causes the
program to run in Demo mode. If this happens, a message box will inform you during program
tnitialisation. Running in Demo mode, MIKE 11 supplies full access to all editors, input files and
editing facilities. However restrictions apply on the number of items allowed when savmg input
files and performing computations.

PLEASE NOTE:

The User Interface of MIKEZero/MIKE 11 are designed such, that a monitor with Supér VGA
resolution (1024x768) is required to view the full content of all dialogs. :

It is indeed possible to run MIKE 11 on a monitor with smaller resolution, but parts of the dialogs
can only be viewed then, if the specific window is moved manually by using the mouse.

DHI Water & Environment  4-1 °




4.4

MIKE 11 Online Help

Following the standards of true Windows application, MIKE 11 utilises an integrated online Help
supplying descriptive information on each of the editors, dialogs and property pages within the
system. The online Help supplies explanations on how to operate 2 specific dialog as well as
descriptions of the parameters present in the specific page. The integrated online Help replaces the
MIKE 11 User Manual previously distributed with the MIKE 11 ‘Classic’ versions. Consequently, -
the User Manual in the new generation of MIKE 11 is an on-line feature!

The online Help can be activated in several ways, depending on the user’s requirement:

1) Use the Help button:
To see the description of a specific functionality, press the Help button and move the
?” to point and click in an editor page or on one of the edit buttons available in the editor.
Please note that this help feature is only available in the netwotk editor.

2) <F1> key seeking help on a specific activated editor page; '
To access the help associated with a specific editor property page press the <F1> key on the
keyboard after opening the editor and activating the specific property page.

3) Open the onlirie Help system for scrolling manually after a specific help page;

Open the online Help system by selecting Help in the main menu bar.




Working with the MIKE 11 User Interface

MIKE 11 Editor Files

File handling

With respect to file handling, MIKE 11 is operated just like any other Windows application. That s,
all file-related operations are performed through the File menu on the Main Menu bar. Please note
that the content of the File menu will change depending on which MIKE 11 editor is in focus at the
time where the File menu is opened. An example of the File menu is shown in Figure 5.1.

Figure 5.1: - File menu from MIKE 11 Main Mens bar

Creating new editor files
To create a new editor file, select File from the main menu bar and choose New to open the ‘New’

dialog (alternatively press Ctrl+N), see Figure 5.2. Expand the tree view in the dialog by clicking ‘+’
or double-clicking the MIKEZero and MIKE 11 icons. The tree view in the ‘N ew’-dialog shows a
list of available Data editors in the MIKEZero environment.

DHI Water & Environment  5-1




- & EVA Editor

448 Batch Simulation

-8 Corelation Analysis & Gap Filling
4T Simulation

-~ River Network

3 AD Parameters
-~ WQ Parameters
EU Parameters

ST Parameters

Eony
e
‘:‘ng i

Figure 5.2 New’ dialog for generating a new MIKE 11 input file

Select the type of file you wish to create and press the OK button or double-click the specific icon.
Selecting an item from the New’ dialog automatically opens the specific editor and data input can
commence.

Open existing editor files o :

To open an existing editor file, select File + Open from the Main Menu bar to activate the standard
Windows ‘Open file’ dialog (alternatively press Ctrl+O). Activate the file type combo box by
clicking the arrow button in the ‘Files of Type’ field and select the type of file you wish to open, see

Figure 5.3. .

5-2 DHI Water & Environment
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IKE 11 Simiulation Files (*.sim11)}

ATKE 11 Simulabion Files 1%

IKE 11 River Network Files {*.nwk11]
Cross Sections {*.xns11)}
Bondary Conditions (*.bnd11)
MIKE 11 RR Parameters(* RR11) .
MIKE 11 HD Parameters {*HD11)
MIKE 11 AD Parameters (*AD11)
MIKE 11 WQ Parameters (*WQ11])
MIKE 11 EU Parameters {~.EU11}
MIKE 11 ST Parameters (*ST11]

Figure 5.3: Fiile open dialog including file type selection combo box

After selection of the editor file to open, the corresponding editor will be automatically opened with
the content of the selected editor file. The content of the loaded data file can now be modified.

Upon termination of an input editing session, the editor file is saved by selecting File + Save from
the main menu bar. You are automatically prompted to specify an editor filename.

IMPORTANT NOTICE:

When saving editor files please specify the full filename including the specific extension for the
editor file used. It is essental that all input files are saved with the correct extension before a
simulation is performed. (Example: saving a Network editor file with the name ‘TEST’, you should
specify TEST.NWKI11’ to ensure, that all files holds the right extension as this is 2 must in order for
the simulation part of MIKE 11 to work properly!

File types

MIKE 11 includes multiple editors each operating on different types of data. Data from these
editors must be saved in separate editor files — utlising the default MIKE 11 file extensions as listed
below.

MIKE 11 Editor File Extension
e Network editor * NWK11

e Cross-section editor * XNS11

¢ Boundary editor * BND11

DHI Water & Environment




5.2

5.3

Time sedes files. - *DFESO

[ ]

e HD parameter file - * HD11
e AD parameter file *AD11
s WQ parameter file , * WQ11
e ST parameter file *ST11

o FF parameter file *FF11

e Rainfall Runoff parameter file *RR11
¢ Simulation editor *SIM11
¢ Resultfiles - *RES11

Integrating Editors — the Simulation Editor

MIKE 11 comprises a number of different editors in which data can be implemented and edited

“independently of each other. As a consequence of the system-of separated editor-files, no direct

linkage exists between the different editors if they are opened individually. That is, it will not be
possible to e.g. view the locations of cross-sections specified in the cross-section file in the
Graphical view of the network editor (Plan plot) if these editors are opened individually.

The integration and exchange of information between each of the individual data editors can be
achieved by use of the MIKE 11 Simulation editor. The Simulation Editor serves two purposes: -

—

. It contains simulation and computation control parameters and is used to start the simulation.

2. It provides a linkage between the graphical view of the network editor and the other MIKE 11
editors. Editing of cross-sections could be 2 typical example, where cross-sections can be selected
from the graphical view in order to open the cross-sections for editing in the cross-section editor.
The linkage requires a file name to be specified for each of the editors. File names are specified
on the Input Property Page of the simulation editor.

Once the editor filenames are specified on the Input page, the information from each of the editors
is automatically linked. That is, you will be able to display and access all data from the individual
editors (such as cross-sectional data, boundary conditions and different types of parameter file
information) on the graphical view of the river network editor.

Working with the Network Editor

The Network editor is 2 very central unit in the MIKE 11 Graphical User Interface. From the
graphical view (the plan plot) of the network editor, it is possible to display information from all
other data editors in MIKE 11. The Network editor consists of two views, a tabular view, where the
rver network data are presented in tables, and a graphical view, where graphical editing of the river
network can be performed as well as data from other editors can be accessed for editing etc.

The main functions of the network editor is to: _
e  Provide editing facilities for data defining the river network, such as
- digitisation of points and connection of river branches,
- definition of weirs, culverts and other hydraulic structures,
- definition of catchments connecting the river model to a rainfall ran-off model.

e Provide an overview of all data included in the river model simulation.
Overview is provided via the possibility of presenting items from the different data editors on
the plan plot, graphical view. The different items can be presented using symbols and lines of
different colours and size — all controlled by the user via the ‘Settings’, ‘Network’ dialog from

/ f 5-4 DHI Water & Environment
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5.3.1

the graphical view.

The tabular and the graphical view of the Network editor are shown in Figure 5.4.

! =3
- < Algrament Ines O £ 40
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= =
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Figure 5.4: Network editor, Tabular and Graphical view

Graphical view

The graphical view is opened as default when a river network file is opened or created. Additional
graphical views can be opened using the ‘New window’ facility in the Window Menu in the Main
menu bar. When creating 2 new network file, the user is prompted to define Area Co-ordinates.
These define the co-ordinate system of the plan in which the river system will be digitised.

The Graphical editor of MIKE 11 provides a large number of facilities for editing and presentation
of the river network. ,

The main features comprise:

e Network toolbar for graphical editing
N é@*&?fiﬁ’};&” 7 ¥

vy w

: b Mﬁm@x AR : R bR i

The tools necessary for creating or editing the river network can be accessed from the network

toolbar. That is, tools can be selected for digitising single or multiple points, connecting points

-and branches, merging or cutting branches, deleting points or branches etc.

£k

¢ Right mouse pop-up menu
From the graphical window, 1t is possible to activate a number of editing facilities from the

editor’s right mouse pop-up menu.
To edit an object through the pop-up menu, place the cursor ata network component (e.g. 2
point, 2 branch or any other symbol) and press the right mouse button to activate the menu.

DHi Water & Environment  5-5
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Selecting ‘Edit...” gives a possibility of editing any object in the vicinity of the selected point:
Use the ‘Insert ’ entrance to insert 2 new object at the selected point in the network. Selecting an
entrance from one of the Insert’s sub-menus will open the corresponding editor. '

‘Point properties’ gives a possibility for changing the selected point’s co-ordinates and chainage
(if chainage type is selected as ‘User Defined’).

Zoom functions

Zoom functions (zoom in, out and previous zoom) can be activated from the zoom toolbar
buttons or from the right mouse pop-up menu. To zoom in, click and drag until the zoom
selection square covers the area in the horizontal plan, which should be enlarged.

Please note that the shape of the zoom-in selection area is identical to the shape of the graphical
view window. :

User-defined settings for display of river network components

The drawing style, size and colours of points, branches and other network components
presented in the graphical view can be controlled from the ‘Graphical Settings’ page in the
Network Dialog. The Network dialog is activated from the Settings Menu in the Main menu bar

Background images

Using the Layers menu from the Main menu bar it 1s possible to unport one or more images as 2
background map for the river network. Image-files must be saved in either GIF- or BMP-
format. '

Location of the image(s) in the horizontal plan can be modified by selecting the image (a red
square appears around the image when selected), activate the ‘Image Co-ordinates’ entry from
the right mouse pop-up menu, and it will then be possible to alter the co-ordinates of the
specific 1 image.

Thereby, it 1s also possible to import multiple images of selected areas within the same river
network file.

Auto functions
In the ‘Network’ menu under the Main menu bar you can activate facilities for auto generating
network components. E.g. automatic connection of branches following logical user-defined
specifications, automatic generation of boundary conditions at all open ends and automatic
update of chainages in the entire network in case points have been added, moved or deleted.
Longitudinal profile
The Longitudinal profile feature is only available if the network file has been opened through a
simulation editor where a cross-section file is associated. It is required to associate information
on cross-sections, as the bed- and bank-levels are presented in the longitudinal profile.
Activate the Longitudinal feature in the “View’ menu from the Main menu bar. Place the cursor
at a branch and click with the left mouse button to select the upper branch in the profile (notice
that the branch is highlighted and the cursor changes symbol when a branch can be selected).
Secondly, place the cursor at the branch which should the end branch in the profile and click.
with the mouse button.
MIKE 11 investigates the number of possible profiles following the path from the first branch
to the last and if more than one possibility exist, a profile selection dialog will appear. Select
profile from the dialog to present the longitudinal profile in a separate window.
If only one path exists from the first to the last selected branch, a window containing the
longitudinal profile will appear immediately.

Metafile options
The nver network can be saved in 2 Windows Metafile format for use in e.g. word processors.
The metafile feature is activated through the View’ menu in the Main menu bar. Metafile can be
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copied to the clipboard for immediate pasting in to other programmes or it can be saved to a file
on the disk.

¢ Import of network co-ordinates from ASCII files. - '
Branch and point (cross-section) data can be imported from ASCII text-files. File format is
described in the On-line Help system.

5.3.2 Tabular view

The tabular view is opened manually by selecting the “Tabular View...” item in the View Menu
(hotkey combination is CTRL+T) or automatlcally, when edmng an existing network object through
the nght mouse Pop-up menu.

The dialog for the tabular view contains a number of property pages. A short description of the
content and purpose of each property page is given below. For 2 more comprehensive description
on some of the items reference is made to the On-line Help system: '

nper s e i

Points ' : ;
The points property page offers a possibility of editing co-ordinates and river chainages of the !
points digitised in the graph.ical view (horizontal plan plot).

Important to notice on this property page is the column, ‘Chainage type where two options are
available; ‘System Defined’ or ‘User Defined’ chainage:
- ® ‘System Defined’ chainage means, that MIKE 11 automatically calculates the chainage from the

digitisation (distance from neighbouring points calculated from the plan plot co-ordinates).

¢ ‘User Defined’ chainage means, that the user can manually specify fixed chainages for specific
reference points (e.g. hydraulic structures, bridges etc., which have been surveyed and found to
have a specific location and chainage).
Additionally, it is recommended always to specify the first and last point in each branch as User
defined, as this will ensure, that the length of the river system is exactly as required.

Please note, that the points information in this property page only includes digitised points.
Digitised points are not used in the computation — only for presentation of the plan plot of the river
system.

Computational points (grid points) used.in the computation can be presented in the ‘Grid Points’

PI'OPCItY page.

Branches _ ]
In the ‘branches’ page, specifications are made on the river branches included in the set-up. Initally, k
a River name must be specified in the ‘Name’ column. Afterwards, the remaining columns must be
edited:
o TopoID
Topo ID is a ‘topographical identifier’, which gives the user a possibility of distinguishing
between different surveys for the same river system. '
Topographical surveys from different years can be stored in the same cross-section file if only
the Topo ID parameter differs. Therefore, the Topo ID specified must correspond to a2 Topo
ID defined in the cross-section file used in the computation —~ otherwise, cross-section data for :
the simulation can not be located. :

® Flow direction
The standard notation of MIKE 11 is, that flow direction is positive with increasing chainages.
This typically requires, that the starting point (zero chainage) are defined as the upper part and
the end the point of the river system are defined in the downstream part of the river system.
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However, in many surveys, the downstream point (e.g. the river mouth at the sea) is the starung
point for the river survey, and this point is therefore required to be the starting point (zero
chainage) for the river model as well. Therefore, in these cases, it is required to specify the flow
direction as ‘Negative’, as the increasing chainages will then be opposite to the standard notation
used internally in MIKE 11.

¢ Maximum dx ' TS
The maximum selected distance between two neighbouring h-points in the computational grid.

¢ Branch type _

The branch type can be selected as one of two: : !
—  Regular:

The regular branch is the standard branch of MIKE 11 comprising water level points at i

both the up- and downstream end, and an alternating grid of water level and discharge

points, |
—  Link Channel: _ ‘

When a branch has been defined as a Link channel type, the ‘Edit Link Channel . i

Parameters...” button is made active. Press the button to open the ‘Link Channel

Parameters’ dialog where Link channel parameters can be specified. ‘ ' -

- Important notice:, o ' : : ' ' ' : '
. B After specification of the link channel parameters, it is required to press the ‘Calculate Q/h .
E W relations’ button in order to calculate the link channels Q-h table, which is used in the 4 _“E"
computation. g
After each modification of any of the link channel parameters, it is required to update the
Q-h table by pressing the button. '

T

E Short description of Link channels: o
g Link channels are ideal for modelling the flow paths between e.g. river and floodplains. : o
¥ B They play an important role in modelling floodplain inundation and drainage. pongl
- Also, floodplain cells can be attached to one end of a link channel. The cell is represented as B
a flooded area versus elevation curve based on the additional floodéed area column of a Bl
cross-section in the MIKE 11 cross-section file. ‘
_ A link channel can be defined to represent an embankment, a natural levee ora tributary. .-
. Flow paths can be lumped together to reduce the model size, i.e. several tributaries and a
B river levee may be represented in one link. _ : -
£ . o .
f . Link structures are similar to a long open culvert. Bed levels at the upstream and -
3 downstream ends, length, bed resistance and head loss coefficient can be specified. The T
cross-section shape is fixed along the entire length and is defined by a depth-width table. e
There is no need for upstream and downstream cross-sections (as is the case with other i
structures). pre=s
Each link 1s treated as a short branch (two h-points and one Q-point). L
T K
e Connections
Upstream and/or downstream branch connections must be specified by River name and et
Chainage respectively. _ o
Weirs ' : _
Data on broad-crested weirs and special weirs (utilising user-defined Q-h relations) are entered in _
this page. These data comprise the location of the weir and the geometry of the weir (that is, a level- _ L.
/width-table describes the geometry). ’
. _tom
B
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Valve regulations can be selected to include e.g. flap gates descriptions allowing flow i1 only one
direction.

Additionally, it is possible to select the weir geometry from a cross-section defined in the cross-
section file. Hence, you must select the ‘Geometry Type’ as ‘Cross-section DB’ and ensure that a
cross-section exists at exactly the same location (river name and chainage) in the associated cross-
section file.

From the entered data, MIKE 11 will calculate Q-h relations for critical flow conditions at the weir.
In order to compute the Q-h relation, the nearest upstream and downstream cross-sections.are used.
Hence, the user needs to ensure, that the Topo ID specified in the Branches dialog corresponds to
the definitions in the cross-section file.
Please note, that:
1. If no cross-section file is associated to the network file through a simulation editor, it is not o
possible to calculate the Q-h relations for any structure. '
2. If changes are made in the nearest upstream or downstream cross-section — or in the weir-
descriptions, it is required to perform a re-computation of the Q-h table prior to the simulation.

Culverts
Data on culverts must be specified in this page. {

The page is very similar to the weir page and offers t}x; same options for specifying valve regulations

and geometry from a cross-section file.

However, some of the variables are specific for the deﬁmtlon of culverts:

o Invert upstream (U/S) and downstream (D/S) elevaton
Elevation is the invert elevation at the upstream and downstream end respectively. These levels
must be higher than the bed level of the cross-sections immediately up- or downstream of the
culvert,

¢ Tength’
Specifies the length of the culvert,

* ‘Manning’s n’ ‘ gf
Specifies the roughness (material) of the culvert, ' B

¢ ‘No. of Culverts * , : -
Specifies the number of parallel culverts at the same location (using same geometry)

After entering the Culvert data, press the ‘Calculate Q-h...” button to calculate Q-h relations for the 3
culvert. The Q-h relations are given as Q-y relations (where y is the depth above invert). Other - I
parameters are given in the ‘Hydraulic Parameters’ page.

If desired, the orifice flow coefficients can be edited as discussed below.

When calculating the Q-h relation, the type of flow occurring are also listed:

e ‘No Flow’
No flow occurs at the first level (y=0) and when the valve regulation flag prohibits flow in one
direction.

o ‘Inlet C
The flow at the inlet is critical.

e ‘Outlet C

" The flow at the outlet is critical. A backwater curve using a fine resolution is calculated to relate
the discharge to the upstream water level in the river. )

¢ ‘Orifice’
The flow at the culvert inlet has an orifice type information. The discharge is based on the orifice ’
coefﬁqents shown in the menu. These coefficients can be edited, added or deleted, if required.
The Q-h relation must be re-calculated after editing the coefficients.
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‘Full Culvert’ ,
The culvert is fully wet with a free discharge at the outlet.

Regulating .
The regulating page offers a possibility for specifying the discharge at 2 certain point (e.g. 2
structure) as 2 function of time or as 2 function of hydraulic conditions elsewhere in the river

Sys tem.

Two regulating types are available:

o Function of Time:
The discharge through the structure is specified as a function of time (e.g. if two channels are
connected to a pump or a turbine). The equation of momentum in the specified Q-point in the
computational grid is replaced by a discharge/time function.
The actual discharge time series must be specified in the Hydro Dynamic Property Page using the
Boundary Editor.
Function of h and/or Q i
Special forms of river regulation can be defined in this page. This structure type is applied where
discharge through a dam is to be regulated as a function of the water level, and the inflow into the
reservoir. The location of the structure and the location of the control points (J1 and J2) must be
defined together with the regulating functions.
The discharge through the dam/structure is calculated as a given factor times the discharge or
water level as a function of h or Q at two locations (J1 and J2) in the river model: Q = £(J2) * J1

Control Structures (HD Add-on module)
Control structures may be used whenever the flow through or above a structure is to be regulated by
the operation of a movable gate, which forms part of the structure.

For detailed descriptions on how to use the Control Structures moaule, please refer to the MIKE 11
User Guide.

The gate position (operation) during the computation can be saved in the HD Additional Output
file. To activate this output feature, you must select ‘Velocities in Structures’ output in the HD
Parameter file, Add. output page.
Dambreak Structures (HD Add-on module) S
The dambreak module is used to simulate breach development in a dam structure due to
overtopping or pipe failure. ‘
The specification of a dambreak requires the user to define relevant information from each of the
following categories:
e Geometric specification

Specify the dams crest level and length (perpendicular to the river flow),

e Limit for breach development- .
Regardless of which shape and mode a breach development has been defined, a limiting section
can be applied. The geometry of the limiting section is specified in the cross-section file.
The limiting section allows an irregular shape to be used to define the breach limits. This is 2
useful feature, which allows the natural shape of the river section at the dam site to be modelled.
Only the section of the dam breach lying inside the limiting section is used for calculating the
hydraulic parameters.

Failure moment and mode
Failure moment can be specified to commence:
1) As a given number of hours after the start of simulation,
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2) Ata specified time,

3) Ata specific reservoir water level. In this case the dam failure will occur when the reservoir
water level reaches the specified level. The reservoir water level is defined as the water level
in the grid point immediately upstream of the dambreak structure.

Failure mode can be defined as either of the following:

1) ‘Time dependent’ '

A known geometry of the breach development is specified as a function of time. The
increase in breach dimensions is specified as time series of; Breach width, Breach level and
Breach slope.

2) ‘Erosion based’ , '
The increase in the breach depth is calculated from a sediment transport formula (Engelund-
Hansen). The increase in breach depth multiplied by the side erosion index. If an erosion
based failure is specified, further information is necessary. This information is entered in a
separate dialog, which is activated by pressing the ‘Erosion Parameters...” button.

Catchments :

Catchment discharge can be calculated by the Rainfall Runoff Module and included as lateral inflows
to the hydrodynamic module. The property page is used to specify the locations of catchments in
the river network. Lateral catchment inflow can be included in either one single point (upstream and
downstream chainage must have the same value) or distributed along a reach of a river branch.

m‘w,;-v; -

E T

Grid Points
The grid points property page has two specific purposes:

e

BT
AL

1. The page presents summary information on the computational network (or grid) points prior to !
the simulation. Press the ‘Generate Grid Point’ button to generate the computational grd, which f’§
corresponds to the grid used in the computation. i

2. The page can be used to limit the number of computational points saved in result files. (e.g. for
large models it is desirable to save only those grid points required and to discard remaining
results thus preventing result files from becoming to large).

The page has no influence on the simulation results and is only for information purposes (i.e. the
user is not required to the press the Generate-Grid Points button prior to a simulation.

e s

Each of the property pages provides access to relevant information pertaining to the page. The
property pages are designed such, that the top of each page contains a complete item description,
where data for each item are specified, while the lower half of the page contains an overview of data
specified for each item, presented in a single row. ‘

Selecting an object from the overview grid control, automatically changes the content of all edit
fields on the upper part of the page in order to view all details specified on the actual data item.
Parameters can be edited in both the detailed and the overview sections of each property page.

Please note, that the ‘Settings’ + ‘Network’ dialog proﬁdes a possibility of specifying settings for
‘Highlight object’. That is, the object being edited in the tabular view can be highlighted in the
Graphical View by a user-defined symbol.

Working with the Cross-section Editor

River cross-section data comprises two data sets, the raw and the processed data. The raw data
describes the physical shape of a cross-section using (x, z) co-ordinates, typically obtained from a
river bed survey. ‘




The processed data is calculated from the raw data and contains corresponding values for level,
cross-section area, flow width, hydraulic/resistance radius. The processed data table is directly
applied in the computational module.

Each cross-section is uniquely identified by the following three keys:

* River name: String of any length.

e Topo ID: String of any length. (topographical identification)
®  Chainage: Real number. (unit: meters).

Raw data view

The raw data view is the default view when a cross-section file is opened or created. An example of
the cross-section raw data editor is shown in Figure 5.5.
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Figure 5.5: Cruss=section, raw data editor

The raw data editor contains three different ‘views”

e  Tree View:
The tree view provides a list of all cross-sections in the cross-section file.
The tree includes three levels, where the upper level defines the rivers names, the middle
contains the Topo-ID(s) for the specific river and the lower provides a list of chainages of the
cross-sections defined for the actual Topo-ID in the specific niver.
Selecting a cross-section from the tree by clicking the left mouse button will immediately
update the tabular and graphical views, as all three views are fully integrated in order to present
the data of the selected section automatically.
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Selecting a section chainage, river name or Topo-ID of a cross-section with the right mouse
button opens a pop-up menu from which it is possible to make changes to the existing content
of the cross-section file (e.g. insert, delete, copy and rename of sections, rivers and/or Topo-

ID’s).

Tabular View: . :

The tabular view contains the raw cross-section data selected from the tree view.

X- and Z-co-ordinates and relative resistance factors can manually be edited in the table.

The resistance (relative resistance) in each row of the tabular view has a default value of 1,
indicating 2 constant value of the roughness across the section. If the roughness is not
constant across the entire section, e.g. on a flood plain or in a composite channel cross-section,
the varation in roughness can be included by entering a relative resistance different from 1 for
a part of the section. The resistance is normally given relative to that of the main riverbed. A
relative resistance greater than 1.0 indicates higher roughness and vice versa.

The marker column lists the location of marker one, two and three each representing the
nver’s left bank, bed and nght bank respectively. It is important to notice that only the part of
a section, which lies between marker 1 and 3, is included when calculating the processed data.
That is, parts of a section can be omitted from the computation by adjusting the location of
markers (e.g. if a flood plain is included in the cross-section data).

The user can modify the location of markers.

Graphical View: ,

The graphical view displays the raw cross-section selected in the tree view.

Depending on the current settings in the ‘Change Options’ page (opened from the Cross-
section item in the Settings menu), the graphical view will overlay multiple cross-sections with
previous selections displayed as a ‘watermark’.

Selecting ‘clear’ in the local pop-up menu (right mouse button) clears the history graphical
display.

Apart from the river name, topo-ID and chainage, it is required to consider whether some of the

other variables identifying each cross-section should be altered. These are:

* Radius type ' ' ,
The user must deftne which method to apply when calculating the hydraulic radius in the
processed data table. Three methods are available; Resistance radius, Hydraulic radius using the
total flow area and Hydraulic radius using the effective flow area. The effective flow area is the
calculated area where the effect of altered relative resistance values is included.

Section type

" Section type can be defined as open (default), closed irregular, closed circular or closed
rectangular. In case of a closed section the hydraulic radius using total area is always used, and
MIKE 11 automatically introduces a preissman slot when calculating the processed data table in
order to allow the computation of pressurised flow.

Datum

Datum adjustment will be added to all z-co-ordinates and all levels when calculating the
processed data. In this way it is possible to link a local datum with a global datum or to correct
for benchmark errors in the raw data.

Divide section

During 2 model computation (typically a morphological sediment transport computation) the
section can be divided horizontally (typically between in-bank and over-bank flow levels). If this
is required the level of divide feature must be activated and the level specified.
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Definition of the above parameters can be done for each cross-section. However, it is also L
possible to apply settings globally (to all sections in the cross-section file) through the ‘Apply to
all sections...” in the ‘Settings” menu in the Main menu bar.

Other features of the Cross-section, raw data editor compnses v
¢ Change options for..
The ‘Cross-section... * entrance in the ‘Settings’ menu allows the user to modify the appearance ]
of the graphical view, as well as defining miscellaneous variables.

¢ Computation of processed data
The computation of processed data is required after entenng raw data, as the processed data 1
tables must be used in the computation.

Two options are available for computation of processed data:

a) The ‘Recompute all’ feature in the ‘Cross-sections’ menu in the Main menu bac
re-computes the processed data for all cross-sections in the cross-section file in one
operation: This is a very useful feature e. g when a large number of new sections have
been entered or many of the existing sections have been modified.

b) Press the View processed data...” button. This will compute the processed data for the
selected cross-section and automaucally open the processed data editor. This feature
however, is only active if the ‘Update processed data automaucally check box 1s
activated.

e Update Markers
The update of markers feature is a facility in MIKE 11 to automatically place the markers 1, 2
and 3 1n case a cross-section has been modified or a new section introduced to the cross-section
file. Markers will automatically (per default) be located at the first x, z co-ordinate (Marker 1), at
the lowest z-value (Marker 2 at the bottom) and at the very last x,2 co-ordinate (Marker 3).
However, only the markers activated in the ‘Cross-section...” (‘change options for...”) dialog will

be automatically updated. -
: Two options are available for updating the location of markers: :
a) The ‘Update Markers’ feature in the ‘Cross-sections’ menu in the Main menu bar : -
updates the location of markers for all cross-sections in the cross-section file in one ’ E
; operaton. prioli
b) Press the ‘Update Markers’ button. Thxs will update the markers for the selected cross- -
section. ) ’ -
The last feature of the cross-section editor to be described here is the Import / Export facility. The -
cross-section editor file is'one of the only file-types in the MIKE 11 environment, which is binary. -
That is, it 1s not possible to read the content of the cross-section file unless opened in the cross- .

section editor and a possibility of exporting the content of the cross-section file to a text-file is =

therefore available. The Import feature is typically very useful when cross-section data from a river

- survey must is to be used in a river set-up. -
- From the ‘File’ menu, select ‘Export’ or ‘Import’ to write or read text-files with cross-section data. A
A KL
5.4.2 Processed data view )
The Processed data view is opened by pressing the ‘View Processed Data...” button in the Raw Data g
' View pra
The Processed data view also contains a tree view (as described above), a tabular and a graphical -
' view, see Figure 5.6. The graphical display can be altered by selecting the desired parameter from the ey
pop down list at the top of the page. ' -
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Figure 5.6: - Cross-section processed data-editor view.

The tabular view contains processed data automatically calculated from the raw data. The processed
data contains corresponding values of Water level, Cross-sectional area, Radius, Storage width and
conveyance. :

Additional storage area (surface area) can also be specified as a function of the water level.

If data has been altered, and it is required to keep the data unchanged in future, it is possible to
protect the processed data for specific sections by activating the ‘Protect Data’ check box.

Please note that the ‘Data Status’ group is not an editable field. The value of the data status is only
an i:xformation to the user, whether the data has been edited or updated during the period where the
processed data editor has been actvated.’

Additional features of the processed data editor comptises:

e Modification of levels in processed data table oo
If the number of levels and or the level values must be modifted this is possible in the ‘Levels for
Processed data’ dialog, activated by pressing the ‘Levels...” button. Select the level selection
method, the min and max level and number of levels and press the recompute button to
determine the new levels for the processed data. If the levels are satisfying press the OK button
to close the Levels dialog.

e Delete and re-compute , )
The entire content of the processed data table can be deleted by pressing the ‘Delete’ button and
recomputed using the automatically or user-defined levels by pressing the Recompute button.

.

e View Raw data.
Pressing the “View Raw Data...’ button activates the raw data editor. That is, the raw data editor
is made active (opened in case it has been closed down).
If the ‘Synchronise Raw Data’ check-box is activated, the raw data editor is synchronised with
the processed data editor such that the raw data for the cross-section presently active in the
processed data editor is presented automatically.
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5.5.1

Working with the Boundary Editors

Boundary conditions in MIKE 11 are defined by combined use of time series data prepared in the
Time Serdes editor and specifications made on locations of boundary points and boundary types etc
in the Boundary editor. : )

That is, the ‘boundary editors’ comprise the Time series editor and the Boundary editor. Both
editors are necessary to activate in order to specify a MIKE 11 boundary condition.

Time series editor

The,appearance of the Time series editor differs if you create 2 new (blank) time series compared to
opening an existing (dfs0) file.

Creating a new time series requires specification of properties for the time series file, and the File
Properties dialog is therefore opened in this case.

If you are opening an existing dfsO-file, the data are immediately presented in the Time series data
dialog where data can be viewed and edited both in a graphic and a tabular view. In this case, if you
wish to change the file already defined file properties, it is required to open the File Properties dialog
from the graphical view. '
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File Properties dialog
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Figure 5.7: Time Series Editor, File properties dz'a/o;g;

In the file property dialog, you must specify information on the dme series axis and information on
the items (series) which should be present in the specific dfsO-file. The axis information comprises;
e axis type: Equidistant or non-equidistant intervals, calendar axis or time relative to 2 specified
start-time or plot of X-Y data,
e start time (date-format follows the standard definition of Windows),
time step (given in days, hours, min, sec),
number of time steps (must always be larger than onel!)

Item information comprises;

e Name of each time sesies item,

e Item type (e.g. water level, discharge, concentration etc.),

o Item Unit (e.g. meter, m3/s, g/m? etc),

e The ‘TS Type’ column are used to define different type of timeseries for different DHI software
packages. However, MIKE 11 does not utilise the ‘TS Type’ settings in the simulations so this
field can just be left unchanged from defult. : : .

o The ‘Min’, “Max’ and ‘Mean’ columns are not editable to the user. Values to these columns are
automatically inserted based on the actual time series data.
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I S i st e ] buttons are used to modify the content of the
Item information table. That is, Items can be appended to the bottom of the table, deleted from
the table or inserted at a selected position by use of these buttons.

When you have concluded the definition of axis and item information, press the &
to activate the Time series data dialog. '

Time Series data dialog :
The time seres data dialog consists of two views, a tabular view and a graphical view (see Figure 5.8.
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Figure 5.8: Time series edstor; Time :eﬁe.r data dialog

e Tabular view: ‘

Presents the time series data in tabular form.,

Copy & Paste functions are available (e.g. copy and paste sesies from Excel),
The time format is determined from the selected default Windows format.

|

o  Graphical view: .

~ Data can be edited graphically by selecting one of the editing modes; Select, Move, Insert or
Delete. .

— When opening a time series file, all items contained in the file are plotted by default. The file
title specified in the file properties dialog is used as a header on the graphical vies, while the
iten names are displayed in the upper left corner of the plot.

— To activate the pop-up menu as shown on figure 5.8 place the cursor in the graphical view
and press the right mouse button.
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From the pop-up menu you have multiple options, like activation of zoom and refresh
facilities, entrances to modify the appearance of the graphical view (enable or disable grid
and legends, changing colour and styles etc.).

Additionally, it is possible to open the File Properties dialog from the pop-up menu by
selecting the ‘Properties...” entry. Thereby, it is possible to alter previous property .
specifications of a specific file (e.g. if you want to add an additional item to the file, it must
be done through the File Properties dialogf).

Boundary editor

The boundary editor dialog contains property pages where boundary conditions are specified for all |
types of MIKE 11 simulations including:

Hydrodynamic,

Advection-Dispersion / Water Quality,

Sediment Transport -
Rainfall Runoff

The boundary editor is shown in Figure 5.9.
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The definition of 2 Boundary condition requires the following actions to be performed - in the order

as listed:

1. Specify the location of the boundary point and the boundary type.
Location of the actual boundary point is defined by a river name and a chainage (in meters). The
boundary type (e.g. water level, discharge, concentration etc.) is selected from the ‘Boundary
Type’ combo-box, which is activated by pressing the ‘Arrow-down’ button.

Use the ' =% button to select a ime series (dfs0).

After defining the location of the boundary point, you must associate a time series to be applied
at the boundary. The time series are kept in separate time series files (DFS0) and it is required to
browse and select a2 time series file for each boundary definition.

2 button to activate the time series Item selector.

A time series (dfs0) file can contain multiple series of different data types. That is, measured

series of e.g. water level, discharge, concentration etc. can all be kept in one dsf0 file, and it is

therefore necessary to specify — after selection of the dfs0 file — which of the items (data series)

from the dfs0 file to be used for the specific boundary condition.

This selection is made through the Item selector by double clicking the ‘Green light bubble’ in
_ front of the name of the Item, which should be applied.

Please note, that 2 ‘Green light bubble’ iri the Item selector shows, that this specific item is of

the same data type as the boundary condition you are presently defining. Ie. that such an item

can be selected. If you see 2 Red light bubble’, it is not possible to select this item as the data

type is different from the boundary condition you are specifying.

B NN NE N

button is used to open the selected dfs0 file for a specific boundary condition
{name of the selected file is listed in the ‘Time series File’ field). That is, the ‘Edit...” button is a
quick way to open a selected dfsO-file in the tme series editor.
Please note that if the “Time series file’ field is empty (no file has been selected), it will not be
possible to use the ‘Edit...” button. Nothing happens if the button is activated.

5.6 Working withl Parameter File Editors

The MIKE 11 parameter file editors are comprised of the Hydrodynamic, Advection-Dispersion,
Water Quality, Sediment Transport and Rainfall Runoff editors. The Parameter editors contains
information on vanables related to the selected type of computation, e.g. the HD Parameter Editor
contains information on the bed resistance as z significant variable for the hydraulic computations.

All parameter editors are designed as dialogs containing a number of property pages in which
specific data can be entered. Clicking the corresponding ‘tab’ in the editor dialog will activate a

proper: ty page.

- 5.6.1 . HD parameter editor

. To run a hydrodynamic computation it is required to create a HD Parameter file. The HD
parameter editor offers a possibility of specifying user-defined values for a2 number of vadables used
during the hydrodynamic computation. The HD parameter editor is shown in Figure 5.10.
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Figure 5.10: HD Parameter Editor

Initial .
Before starting a2 computation, the user must select how the initial conditions will be specified. r
MIKE 11 can automatically compute a steady-state profile in the river or the channel network
compatible with the given boundary conditions at the specific computation start time in the
simulation editor. Altematively, the initial conditions may be obtained either from an existing result
file-(a so-called ‘Hotstart’) or from manually specified initial conditions of corresponding values for
Wiater levels and Discharges in the entire network at the start time of the computation.

A global initial condition (water level and discharge) can be entered. This global condition is applied L
throughout the model, unless otherwise specified. It is possible to specify a number of river reaches !
or channel reaches; ‘Local values’, where initial values of water level and discharge different from the E
global values are to be applied.

Figure 5.10 shows an example of such a specification. A global water level of 2.5 m and a global
discharge of 12 m3/s have been specified. In the branch ‘RIVER 1” between chainage 0 m and 2500
m, alternative conditions are given. These indicate that the initial water level varies linearly between
2.3 m and 2.5 m and the discharge between 10 m?/s and 12 m?/s in the specified niver re;ch.
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If the user wishes to include Wind shear stress it is required that a time variable boundary condition
for Wind Field are included in the simulation. The Wind Field boundary condition consists of
specifications for Wind direction (towards North) and the Wind velocity.

In the Wind page of the HD Parameter dialog, the user can activate the usage of Wind field in the
computauon by activating the ‘Include Wind’ check box.

The time varying boundary condition defines the wind field, but local variations must often be taken
into consideration. This can be done by specifying a topographic wind factor (topo factor), and if 2
topo factor is defined for a particular reach, the wind velocity used in the computations will be
applied as the velocity multiplied by the topo factor.

Bed Resistance _

The resistance number must be specified in this page. The resistarice number can have one of three
different forms, of which Manning’s M is default:

- Manning’s n

- Manning’sM M = 1/n)

- Chezy number

The resistance number specified on this menu is multiplied by the resistance factor specified for a
given cross-section (and water level) in the processed data of the Cross-section file during
‘computations.

Global and local values for the resistance number can be defined. During a calibration exercise,
typically, the resistance number is the most significant variable to adjust, and therefore, you will
typically need to specify (a number of) local values to account for local variations in the topography,
vegetation etc.

Wave Approx

It is possible to specify which wave approximation should be used in the computation, viz
Kinematic, Diffusive or one of two fully dynamic wave approximations.
Default is the dynamic wave. :

Default Values

In this page it is possible to alter the value for a number of parameters connected to the
hydrodynamic computations.

Parameters should not be altered, unless thc user is familiar with the effect on the results. A more.
detailed explanation of the various parameters is given in the MIKE 11 On-line help system and
MIKE 11 Technical Reference manual.

Quasi Steady '
A number of Quasi-Steady Control parameters connected with the Quasi steady computations are -
entered in this page. Detailed description can be found in the MIKE 11 On-line Help and MIKE 11

. Technical Reference manual.

Add. 0utput

' Additional output can be produced upon request by the user. This extra facility is available as a

supplement to the hydrodynamic result file. The additional output is stored in a file with a similar
name as the HD result-file name. Only difference is that an addmonal string ‘HDADD” is added to
the filename of the HD result-file name.

Example: if the HD result filename is ‘HDRES1.RES11’, the name of the additional output ﬁle
would be; ‘HDRES1HDADD.RES11’

To activate the additional output, the user must activate the check-box in front of the item to save
to the additional output result-file. '
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Flood Plain Resistance

Normally, the resistance numbets on flood plains are included through editing the relative resistance
factors above ‘Level of Divide’ in the Cross-section editor, Raw data specifications. Hence, it is
possible to reduce the effective flow area as a function of the water level. Another possibility of
changing flood plain resistance numbers is to edit the Resistance Factor in the Processed Data in the
cross-section editor. ’

However, if the modelling task does not require a water level dependent resistance on flood plains, 0
an overall Flood Plain Resistance number can be specified in this page. :
Please note that flood plain resistance numbers ‘are only applied above the Level of Divide’. Hence,
it is required also to modify the cross-section data in order to activate this feature.

A global resistance number on the flood pIa.ins in the model can be specified. This is applied on all
flood plains unless local values are specified. Local specified values are linearly interpolated. Giving
the value 99 as resistance number indicates that the flood plain resistance number should be
calculated from the faw data in the cross-section file.

User Def. Marks .
The User Defined Markers page offers a possibility for the user to define items in the modelling :
area, which they would like to present on a longitudinal profile from MIKEView, (e.g. gauging
stations, bridges etc.). Markers can be defined as single points at a specific chainage or as a marker
with a certain length between two chainages in the same river stretch.

5.6.2 AD parameter editor

The AD Parameter file is required in order to run an Advection-Dispersion (and a Water Quality) °
simulation. The AD parameter file contains information on each of the pollutant components
included in the simulation. The AD parameter editor is shown in Figure 5.11.
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Figure 5.11: . AD Parameter Editor

Components B .

In this page, the name, unit and component type must be specified for each of the substances
(components) to be included in the Advection-Dispersion computations.

Unit and component type (Normal, Single Layer Cohesive, Multi Layer cohesive or Non-cohesive)
must be selected from the corresponding combo-box. To actvate the combo-box activate e.g. the
unit field and press the ‘down-arrow’ appearing after the field has been selected.

The ‘Fill WQ Components’ button can be used to automatically define the WQ model to be used in
'a WQ computation. After selection of the WQ-model type and level, the component table is
automatically filled with the component names, units and order of components. The order of
components is very important if you are performing a WQ-simulation.

Dispersion .
The dispersion coefficient and factors are specified in this page. Dispersion can be specified as a
functon of the flow velocity calculated by the following expression:

D = f*yzx’

where: .

D is the dispersion coefficient (m?/s)
V is the flow velocity (m/s)

f is the dispersion factor

ex is a dimensionless exponent
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Minimum and maximum dispersion coefficient values are specified to limit the range over which the
calculated dispersion coefficient may vary.

Init. Cond. _
Initial conditions, i.e. initial concentrations of each component are specified in this page.

In the Component column, select from a combo-box the component for which you wish to specify
initial conditions. The combo-box in the component column lists the components speciﬁed in the
‘Components’ page and a specific component can be selected from the list.

In the Concentration column specify the initial concentration of the component in the unit selected
in the Components page.

Both global and local initial conditions can be specified for the same component. If you wish to
specify local variations in initial conditions de-activate the ‘Global’ check-box and specify the
location (river name and chainage) of the initial condition for the specific component. The global
value will be used everywhere except in those reaches where additional local values have been
specified. If no value is entered for a component, a global concentration of zero will be applied
automatically. '

Decay
It is possible to specify one or more non conservative components, i.e. the concentration is assumed.
to decay according to the first order expression:

dC/dT = K*C

where, K is the decay coefficient (hours') and C is the concentration.

If the data entered are used in connection with a water quality computaton, the user should not
specify the decay coefficients, as the special water quality model computes these coefficients.

Boundary

Information on the boundary points in the model area must be specified in this page.

One of three different boundary types must be defined for each boundary point — but which one to

apply:

e Open Concentration Boundary
Open concentration boundary conditions should be applied 2t locations where outflow (of water
and component mass) from the model area occurs. Open concentration boundaries in the AD
model correspond to water level or Q-h boundaries in the HD model. At each open boundary, a
time series of the concentration must be specified in the boundary editor (:bnd11 files).

When flow occurs out of the model, the concentrations at the boundary point are computed
within the AD model. For flow into the model (e.g. at flow reversal in tidal applications), the
specified boundary concentrations are used. (These inflows are assumed to be unaffected by the
previous model outflows).

The parameter, K-mix, is used to ensure a smooth transition between calculated and specified
boundary concentrations in the case of a flow reversal.
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® Open Transport Boundary
Open transport boundary conditions should be used at boundaries where only inflow takes
place. The transport into the model area is computed using the specified boundary concentration
and the discharge computed by the HD model. It is important to note that the computed
concentration at the boundary point can therefore differ from the concentration specified in the

; boundary file.

| K-mix is not used at open transport boundaries

Ca D R

¢ Closed Boundary
Closed boundaries occur where no mass is transported in or out of the model area. A closed
boundary condition should only be specified in this menu if a similar closed boundary condition
has been specified in the hydrodynamic computation (ie. Q = 0).

i Closed boundary points do not need to require concentration time series.

: Cohesive ST

‘M Data used for the cohesive sediment transport models are entered on this page. When using the

- : cohesive sediment transport models (either the simple or the advanced) all components specified in
' the AD editor must be defined as ‘Single layer cohesive’ or ‘Multi layer cohesive’ in the Components
dialog.

The cphésive sediment transport parameters can only be accessed when a component type on the ¢
Components’ page is defined as either single or multi layered. Global and local parameter values can
be specified as required.

Sediment Layers
Initial conditions for the sediment layers are defined on the Sediment Layers page. Selection combo-
> § boxes are available for the component types ‘Single cohesive’, ‘Multi cohesive’ or ‘Non cohesive’.

When the single layer model is used only one sediment layer is displayed. When a multi layer
cohesive model is applied, three layers, upper, middle and lower are displayed. Parameters must be
specified for each layer on three separate rows.

Non-Cohesive ST

This page contains input parameters for Non-Cohesive components. A non-cohesive component is
defined using the data section at the bottom of the page.

Ice Model
This property page contains parameter information for the MIKE 11 Ice module.

Additional Output

The additional output page contains check-boxes, which can be used to store internal model
parameters in an additional AD result file. The name of the additional AD result file is similar to the
AD result-file name. Only dlfference is that an additional stnng ‘ADADD’ is added to the filename
of the AD result-file. name.

Example: if the AD result filename is ‘ADRES1 RESI 1°, the name of the additional output file
would be; “ADRES1ADADD.RES11’

- 5.6.3 ST parameter editor

To run'a non-cohesive sediment transport simulation it is required to give specifications on e. g
sediment grain size (grain diameters) to calculate the correct transport and eventual morphological
changes.
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MIKE 11 permits the computation of non-cohesive sediment transport capacities together with
corresponding accumulated erosion/sedimentation rates, using several different transport and .
calculation models. : . . ‘

The MIKE 11 sediment transport model operates in two ‘modes’:

e Explicit sediment transport model _
In the explicit model the sediment transport computations are based either on the results from an
existing HD result file or from a2 HD computation made in parallel using characteristic transport
parameters. Sediment transport is calculated in time and space as an explicit function of the
hydrodynamic parameters (ie. discharge, water levels etc.), previously calculated. There is no
feedback from the sediment transport computations to the hydrodynamics.

® Morphological sediment transport model
The sediment transport computations are made in parallel with the HD computation. The .
sediment transport is calculated in time and space as an explicit function of the corresponding
values of the HD parameters calculated in tandem. The resistance number may be updated and :
the bottom level is updated so that changes in flow resistance and hydraulic geometry dye to the
sediment transport can be included in the HD computations. :
This model requires sediment or bottom level boundary conditions at all inflow boundaries.

Variables for the sediment transport model are specified in the ST parameter editor, see Figure 5.12.
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Figure 5.12: ST Parameter Editor
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Sediment Grain Diametet -
o Sediment Grain diameter and standard deviation to be used in the ST computation are specified in
n this page. Grain size and standard deviation may be specified as being applicable globally and locally.

Transport Model

Selection of transport model to use and specification of parameters and constants for the specific
transport model must be given in this page.

The transport model is selected by the ‘Model Type” combo-box.

= | A detailed description of the parameters of this page can be found in the MIKE 11 On-line help.
E One variable to mention here though, is the check-box for ‘Calculation of Bottom Level’. This
E ) check-box differs between the two sediment transport modes; explicit and morphological such, that
if the check-box is activated, MIKE 11 will operate in a morphological mode and therefore, the ST
' computation must be made in parallel with a HD computation.

Calibration Factors

The factors; ‘Factor]’ and ‘Factor2’ can be applied to the calculated transport rates as correction
factors. Bed load transport is mulnphed with ‘Factorl’ and Suspended load transport is multiplied
with ‘Factor2’.

If the sediment transport is ca.lculated as total load ‘Factor?’ is applied. These factors can be applied

globally and locally.

Data for Graded ST
Input data for the simulation of graded sediment transport and sediment sorting are specified in this

page.

The bed material is represented by two layers, an active layer overlying an inactive, passive layer.
Each layer is divided into an equal number of fractions (or classes) specified by the user. A mean
grain size (mm) for each fraction and the percentage distribution for both the active and the passive
layer must be specified. The fraction mean grain sizes are global but the initial percentage size
distributions may be specified globally or locally. _
The sum of the initial percentage distributions for both the active and the passive layers must equal

100%.

o A oo 0

Shieldihg of particles can be included by activating the ‘Shielding of particles’ check-box, and
additionally, the user can select the percentage contribution and transport rate of each fractxon to be
saved to the ST result file by act:waung the corresponding check-box.

Preset distribution of Sediment in nodes
The default distribution of sediment at a node is carried out according to the ration of flow
discharges. A user-defined distribution can be specified in this menu by giving the distribution
coefficients and exponents (K and n variables in the distribution relationship - please refer to the
MIKE 11 On-line help for more detailed information). :

Passive Branches : _
Branches, in which sediment transport should not be calculated, are specified by giving the river
name as well as the upstream and the downstream chainage. ' '

Sediment can be transported into a passive branch, but no sediment can be transported out of 2

passive branch.
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WQ parameter editor

To run a water quality simulation the user should enter the WQ parameters according to the
following twelve groups or menu sets.
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Figure 5.13: WO Parameter Editor

Oxygen processes

The oxygen processes parameters are specified in this Menu (see Figure). The global values will be
used by the water WQ module throughout the nver system. However, local values can be
substituted for specific river locations.

Temperatute

In the temperature menu, the location of the niver is indicated (latitude). The following global
and/or local parameters are specified i

Maximum absorbed solar radiation

Maximum displacement of solar radiation from noon

Emitted heat radiation from the water surface
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Degradation of organic matter in the water phase

In the Degradation in the water phase menu, the following global and/or parameters are specified:
First order decay rate for both dissolved and suspended BOD

Temperature coefficient for both dissolved and suspended BOD

Value of the half saturation oxygen concentration in the Michaelis-Menten expression

Denitrification

In the Denitrification menu, the following global and/ or local parameters are specifted:
Reaction order for denitrification (n=1 or n=0.5) .
Nitrate decay rate at 20°C

Temperature coefficient for decay rate

Coliforms

In the Coliforms menu, the following global parameters are specified:
First order decay for both fecal and total coliforms

Temperature, sahmty and light coefficients for decay rate

Light coefficient extinction

Salinity

P. Contents

In the Phosphorus contents menu, the following global and/or local parameters are specified:
Ratio of phosphate released at the degradation for dissolve as well as suspended BOD and at the
degradation of BOD at bed.

Uptake of phosphate in plants

P. exchange with the bed

In the Phosphorus exchange with bed menu, the following global and/or local parameters are
specified:

Resuspension of particulate inorganic phosphorus

Deposition of particulate inorganic phosphorus

Critical flow velocity

P. processes

In the Phosphorus processes in the water phase menu, the following global and/or local parameters
. are specified:

Decay constant for particulate phosphorus

Temperature coeffictent for decay

Formation constant for particulate phosphorus

Temperature coefficient for formation

Degradation at the bed

In the Degradation of organic matter at the bed menu, the followmg global and/or local parameters
are specified: :

First order decay for sediment BOD

Temperature coefficient for decay of sediment BOD

Sediment oxygen demand at 20°C

Temperature coefficient for sediment oxygen demand

Bed/Sediment

In the Bed/Sediment menu, the following global and/or local parameters are specified:
First order adsorpton rate of dissolved organic matter

Resuspension of organic matter from bed

Sedimentation of suspended organic matter

L( 5-30 DHI Water & Environment




dimentation of BOD
the bed

f organic matter in

Critical flow velocity for resuspension/se
Critical concentration o

Nitrogen contents

MIKE 11

g global and/or local pammetérs are specified:

suspended and BOD at bed decay

owin:

cation

o
378
Rl
v 0.5
S 2
29 8
g .08
md.m
e g2
nwm
3
-k
C.mo
& 6

L &
9)

8 dg
Z%Y o
g o 4
.m.um.
gD

Nitrifi

5-31

nment

ﬁeci

g global and/or local parameters are spect

trification (n=1 or n=0.5)

DHI Water & Envi

Wi

gon

ifica

t for decay rate

1en
nitr

fication menu, the follo

itrl

Inthe N
Oxygen demand by

Reaction order for ni
The contents of the file should be saved and the name of the file should be specified on the input

Ammonium decay rate at 20°C
page of the simulation editor.

Temperature coeffic



6.1

SETTING UP A SIMULATION

Using the Simulation Editor

The Simulation Editor combines all information necessary for MIKE 11 to perform a simulation.
This information comprises type of model to run, name and location of input data files, simulation
period, time step etc. and name of result files.

Figure 6.1: Simulation Editor of MIKE 11
The Simulation editor contains 5 property pages in which data must be specified.

Models property page , .

Select the models (HD, AD, ST, WQ etc.) to be included by activating the checkbox for the specific
simulation model,

Additionally, you must select the simulation mode (Unsteady or Quasi steady simulation)

Input property page
Specify the location of input files to be used in the simulation. The type of input files necessary for
the simulation is identified by the colour of the edit fields. If the field is white the field can be edited

-and 2 file must be selected. If the field is grey (‘dimmed’) it is a non-editable field and the specific
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MIKE 11

: input file is not required for the simulation. One exception though, is the edit field; ‘RR Results
; (*RES11)’ which is used to specify an input file from the Rainfall Runoff simulation only. If you do
not require any runoff input from a Rainfall Runoff simulation, this field should just be left blank.

oy

5), ‘ Input files can be located in any directory on the disk. Use the 2 button to browse a specific input
file in a file selection box.

If a filename has been specified in a filename field, you can use the =2} button to open the file

in its corresponding editor

anannNnnNnegrnr

Simulation property page
E Lo In the Simulation property page, information on the simulation period, time step and type of initial
E | condition must be specified.
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There are two ways of specifying the simulation period:

1. Specify manually the simulation start and end time respectively. The date-format to be used for
the simulation start and end time must be the same as Windows utilises (e.g. yyyy-mm-dd hh-
mm-ss)
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2. Press the button to let MIKE 11 automatically determine the minimum and
maximum date and hour where all time series (defined in the boundary file) have common
'periodé. The date and hour for start and end time respectively are then automatically inserted in
the field. . ' .
If no common period exists for the time series defined in the boundary files, nothing happens
and the value in the Start and End date fields are not modified. :

After specifying the simulation period, the simulation time step must be defined. Specify a value for
the time step and select the unit (days, hour, min, sec).

The Time Step multiplier for Rainfall Runoff (RR) and Sediment Transport (ST) modules can also
be specified in case one of these models is selected. :

The Time step multipliers are used to adjust the time step applied for these models. E.g. in ST-
simulations it will often be necessary to run the Hydrodynamic.model using a much smaller time
step than required in the ST model. That is, the time step used in the RR and/or ST model is
therefore the multiplier-value multiplied the simulation time step. o
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Type of Initial condition
o Steady State: .
MIKE 11 calculates automatically 2 steady state profile for the entire model,

¢ Hotstart:
Initial conditions are read from

e Parameter File:
Initial conditions are read from Input Parameter file (e.g. HD Parameter file).

results of previous simulation (define a result-file)

Results property page
Specify the filename for results from the simulation.
Storing frequency can be used to decrease the size of result-files by reducing the number of time

steps saved. (e.g: Storing frequency specified as 10 means that results are saved in the result-file for

every 10 ume-step only).

Start property page '
In the Start property page you will find two validation groups. One group informing on the status of

the simulation (are all input files required for the simulation specified? do the time series files used
for boundary conditions have a common period —and is the simulation period withi this period?).
If a problem exists, 2 red light symbol is displayed in the validation group and it

will not be possible
to start the simulation. If all input files are satisfactory, a green light symbol is displayed and pressing

the Start button starts the simulation.

6.2 Simulation Editor File - also a Simulation-Log

All information specified in the Simulation editor are saved in a Simulation editor file (*.sim11). The
sim11 file is — as most of the other editor files in MIKE 11 —2n ASCII text-file. It is therefore
possible to view the content of these input files in any word processing program (like Notepad,

Works, Word etc.).

Occasionally, it i required to go back in ttme and investigate results and/or input from previous
projects, and it is therefore necessary to keep2 log of the simulations performed (input files used,
time step etc). If you are running several simulations (e.g. using different input files or simulatdon
periods) it is therefore advisable to save the input for each simulation in a separate Simulation editor

file.

keep an additional, separate log

Saving each simulation in separate simulation file you do not have to
files, which identfies the

pf each individual simulation. Simply specify a name for the simulation
content of the file and eventually the purpose of the simulation.

DH! Water & Environment 6-3
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MIKE 11

7 MIKE 11 TUTORIAL

7.1 What will | learn?

Following the instructions given in this tutorial users with no experience with MIKE 11 4.0, will be
guided through the set-up of a simple river network, cross-sections, boundary conditions, HD
parameters and simulation parameters as well as presentation of simulation results.

Contents

1. Network Editor. Basic Facilities.
2. Cross-section Editor.

3. Boundary and Time Sedes Editor.
4. HD Parameter Editor.

5. Running a Simulation.

6. MIKE View.

7.2 Network Editor — Basic Facilities

The aim of this exercise is to introduce the basic facilities of the network editor, i.e. how a system of
branches is defined and connected. '

Start MIKE 11 to produce the MIKE Zero base screen. The MIKE 11. river network file is created

- here using the File menu and selecting New from the menu. A MIKE 11 river network screen is
created with default area co-ordinates. The size and position of both the MIKE 11 window and the
river network window may be changed to allow for easier viewing of river branches defined later in
this tutordal.

Defining a btanéh

Defining and editing a river network is mainly undertaken using the river network toolbar:

S
me———
Sl iy

sl

Figure 7.1: Network toolbar

More details on the functionality of each of the buttons can be found in the help system under the
topic “Graphical Editing Toolbar”.

To define the branch shown below you should select the 22 button in the toolbar and define the
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MIKE 11

T m

branch‘by clicking the left mouse button once at the position of each river point. Start at the
upstream end of the river branch (which is assumed here, to be in the upper part of the window).
The last point in the branch should be defined by a double click.

T

ot

i |1 Netd - Modificd

s Tk Sl
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Figure 7.2: Plan plot, one digitised branch

i

el

Chainage in points ; A
Once 2 branch is defined the chainage of each point is calculated automatically based on the distance
between the digitised points. The default chainage of the first point in a branch is zero. See the topic
“Chainages in Points” in the help system for more details. The calculated chainages may not be
optimal and the user may wish to set the chainage manually. This can be done in two ways:

1) |

Click with the right mouse button at the point for which the chainage is to be changed and a Pop-
Up Menu will be displayed as shown below. See the topic Pop-Up Menu in the help system for
more details. . ‘
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ST

Select the item Tabular View in the View menu and
shown below:

change to the Points page of the tabular view as

MIKE Zero - Nett
R

SR

Figure 7.5: Graphical and Tabular view, Network editor

This page contains information about each point and allows the user to change the chainage type

and value. The graphical and tabular views are linked such thar the highlighted points in the each of
the views are always the same. '

In the above river system the chainage type should be set to user defined for the first and last points rvm
of the river branch with the chainage assumed to be 2 and 100000, respectively.

'. aw -
Display of objects . _
When 2 branch is defined a label indicating the name and chainage from upstream to downstream -
may be displayed adjacent to the branch. The display of these labels, as well as any other object
shown in the graphical view of the river network editor, can be controlled through the Network - os

Settings dialog shown below. This dialog is activated by selecting the item Network in the Settings i
menu. See the topic “Graphical Settings Property Page” in the help system for more details.
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In the figure below, eight points in a tributary have been digitised using the tool. Note that the -
points appear in the list of points in the tabular view, but there is yet no information on which
branch the points belongs to.
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Figure 7.7: One branch defined, second branch digitised

. . 7 (g .
To connect the eight points the tool 2 or g can be used (start at the left most point) and when
the connection is done the screen should look similar to the following.

Note that the branch information is now available in the list of points in the tabular view. The

chainage type should be set to user defined in the first and last point and the chainages set to 12000
and 27000, respectively. )
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Two branches defined with user-defined chainages in up- and downstream points
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Before connecting the two branches each should be given identification names. This is done on the
branch page of the tabular view where the river names are changed to Main and Trib as shown
below. For both rivers the Topo ID should be set to 1997.

70000 F = v mdememmmnnifeeennn it

G !

00000 ;27 Postive
S Postive

AB 3 Figure 7.9: : River Names defined as Main’ and Trib’

B 1 Er

E I To connect the tributary to the main river the 23l should be used. Point at the down stream end of

E i the tributary and while clicking and holding the left mouse button move the cursor to the point on

E 1 . the main branch you wish to connect and then release the mouse button. The connectionis - -

‘BE indicated by a line as shown below: ‘

g 1

: o

1o

ik

Figure 7.10: Connection of river branches : 1.
The contents of the network editor should now be saved by selecting the Save item in the File ' (-
menu. '
-
s,
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Cross-section Editor

The aim of this exercise is to show how cross-sections are created and then to establish links
between the network editor, the cross-section editor and other editors.

The latter requires the use of the simulation editor, which in general serves two purposes:

1. Itallows the user to specify a range of simulation parameters such as file names and time step
and it allows a simulation to be started. S

2. It enables the network editor to communicate with other editors. This communication could for
instance be to receive from the cross-section editor a list of locations with cross-sections.
Another example is when the network editor instructs the cross-section editor to insert a cross-
section at a specific location. Such communication requires that a file name for each of the .
editors is specified. This takes place in the Input Property Page of the simulation editor.

In the simulation editor file names for both the network and cross-section files are required, and to
do so an empty cross-section file needs to be created. This 1s done by selecting New on the File
menu followed by Save and then Close. Similarly an empty simulation file has to be created and
saved.- : o ' : T

The simulation file is loaded and on the Input page of the simulation file editor the name of the

network file and the empty cross-section file is specified using the B2l button. The network file can
now be accessed using the Edit button on the simulation file menu.

Cross-section is required to be inserted at upstream and downstream end of both branches. This is
done using the Pup-Up Menu. Point at the upstream end of the Main branch and click at the right
mouse button and select Insert, Network, Cross-section, as shown below:

NELIIRK )

[

Figure 7.11: ) U:ing the Right mouse pap-u‘é menu to im‘e"rt new cross-section
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The cross-section editor will appear and the data for the cross-section can be entered as shown. The
name of the branch and the chainage will be automatically transferred to the cross-section editor.
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Figure 7.12: Cross-section edetor, raw data editor

Once the raw dﬁta has been entered the button View Processed Data should be pressed to display
the processed data tables.

7-10 DHI Water & Environment




AR N A
T L

5

v i

T Main - 2000 22000°

R

2
R DI

5%
TARIEE
Water levs!

. 1

e cmammmmmemmane
. B

'

i
.
'
.

s

eefarccevanadracnacsceenend

sl5lele

T

g

IEEE

1
o
R
»
§

v Ty
5 10
Cross section area a4}

Figure 7.13: Cross-section editor, Processed data editor

Similar cross-sections should now be inserted at the downstream end of Main branch and at both

ends of Trb branches.

The cross-section file is now saved and closed.
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Boundary and Time Series Editor

The aim of this exercise is to create time series and boundary conditions.

The boundary condition at the upstream ends is zero discharge and at the downstream end the
water level varies between 5 and 6 meters. First the file containing the variation in time of the water

level and the discharge must be defined and to do so a new time series file is created from the New
item on the File menu. The properties for the file should be entered as follows:

: File Properties

N e = . v £ : £

2

e
Heiineen
& s oA
Lol me,

Figure 7.14: Time series File Properties’ dialog

The format of the start time follows the standard windows format, which depending on the
" configuration of your PC might be different from the above shown.

Once the OK button is pressed the time variation of the water level can be entered as follows. The
discharge values are to be kept as zeroes.
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Figure 7.15:  Time series editor, two items included in time series file

The content of the time series editor should be saved and closed using the File menu.

An empfy boundary file must now be created, similar to the way in which an empty cross-section file
was created earlier in this tutorial. The name of the file should be specified on the Input page of the
simulation editor.
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i

The location and type of boundaries can now be specified through the network editor where the
Pop-Up Menu is used to insert the boundary at the down stream end of Main. The boundary editor
now pops up and the location of the boundary is automatically transferred as shown below:

3 : BOUNDARIES.DFSO
B- Water Level
iH

o v 5 .

»;

SRR ISRTEN
R A RN

Figure 7.16: Boundary editor, defining downstream boundary condition

The time series file must be specified using the Browse button and afterwards the correct item can
be selected in the time series file. This is done using the Items button, which starts the item selector
as shown:
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Figure 7.17: Time series, Item selector dialog. ‘Green button Items’ can be selected.
Press the help button to get more help on how to select the item.
In a similar manner the discharge boundaries at the upstream of both Main and Trib must be

inserted and the correct file and item has to be selected. The boundary editor should now have the
following content: :
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Figure 7.18: . Boundary conditions for the tutorial set-up.

The content of the boundary editor can now be saved and the editor closed using the File menu.
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HD Parameter Editor

The final data required to run a simulation is the HD parameters, and to define those HD Parameter
File is created through the File menu. The only parameter to be changed from the default values in
this tutorial dre the initial water levels. This is specified on the left most page of the HD Parameter
file as shown. The initial water level should be 5 metres.-
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Figure 7.19: HD Parameter file, Initial conditions

The contents of the file should be saved and the name of the file should be specified on the ihput
page of the simulation editor.
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7.6 Running a Simulation

In order to run the simulation the pages of the simulation editor must be set-up as shown in the

following diagrams.
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Figure 7.22: Simulation period, timestep and initéal condition selection for simulation
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MIKE 11

Figure 7.24: Ready 1o start the simulation — press the ‘Start’ button
When the start button is pressed the simulation will start and a new window will appear indicating

the progress of the simulation:
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Figure 7.25: Simulation progress dialog

Once the simulation is complete the window will disappear ana the results of the simulation can be

inspected using MIKE View. . .
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MIKE View TUTORIAL

8.1 MIKE View in General

The MIKE View program has been adopted as the result viewer for MIKE 11 . In the current .
release MIKE View has not been integrated into MIKE 11 4.0 structure and therefore, must be

started as a stand-alone program.

MIKE View offers a variety of functions and features for viewing and analysing simuladion results
produced by the MIKE 11 system. The main presentation features comprise: '
Colour plan plot of the river network
Longitudinal profiles _
Time series plot (Several events can be presented on the same plot).
Animation of water level in cross-sections
Results from several result-files can be included for compatison.
Plot of Q-h relations ' '
Animation of user-specified result items (plan plot; longitudinal profiles and time sentes). .
Zoom facility in all windows ’
Scanned images of background maps can be loaded
" Hard copy of all plots

One of the most interesting options in MIKE View is the ‘show synchronised’ feature. This feature
allows the user to play back the results of one or more simulations while viewing the results from
several types of display windows; all fully synchronised. This option opens the possibilities of;

e  viewing a plan view (e.g. with water levels or concentrations) together with a longitudinal
section, oneé or more time series and a Q-h relation plot, for a single simulation fully
synchronised in time. .

e viewing two sets of plan views, time series etc. for two alternative simulations, shown together
and fully synchronised

e  viewing synch:on.ised output frotm MIKE 11 and the DHI Urban Sewer modelling product;
MOUSE, showing Combined Sewer Overflow (CSO’s) from MOUSE which pass into the
dver, the resulting hydrodynamic impacts and the effects on river Water Quality parameters.

More detailed information on the use of MIKE View can be found in the ‘MIKE View User
Manual’ and-the integrated on-line Help available within MIKE View. Descriptions and useful
information on the dialogs and other available features are well described within the on-help system.
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8.2 MIKE Print

The MIKE Print program has be adopted as the presentation graphics editor in MIKE 11 . MIKE
Print is a plot composition tool specifically designed for the production of report style drawings of
MIKE 11 simulation results.

With MIKE Print it is possible to compose 2 page with different types of graphical output (network
drawings, time series etc.), preview the result on the computer display and send the final production
to the printer when satisfactory. Plot layout templates can be saved and reused for at series of
production simulations.

To familiarise yourself with the MIKE Print software please run the enclosed Screen cam recording
of a MIKE Print session. The file name for the Screen cam recording is ‘MPDemo.Exe’ and the file
is located in the ‘MIKE 11\bin’ directory.

8.3 What Willl Leafn in the MIKE View Tutorial?

This tutorial will guide you step by step through the basic features of MIKE View. The result file
included in this tutorial is a MIKE 11 result file (ongmates from the Vida demonstration example
enclosed with the MIKE 11 Installation), but the main principles shown here are also applicable for
the viewing of MOUSE result files. MOUSE is the DHI system for modelling of Urban Sewer
Systems.

When going through the tutorial, you will get the feeling of the most important features of MIKE
View. With the help of the MIKE View Manual and the MIKE View online Help you should be
able to get optimal results in your work with MIKE View.

8.4 Before You Begin

You can work with this Tutorial without any prior experience with MIKE View. However, at this
stage MIKE View should be properly instalied and you should be able to start the program,
otherwise refer to the MIKE View User Manual, before you begin.

Please note, that even though MIKE Viewis a user-friendly presentation tool for urban
drainage systems, rivers and canal networks, the successful usage of the program requires
some basic undetstanding of the respective hydraulic engineering areas.

A copy of the result file used by this tutorial is automatically installed on your computer. It is located
in the ‘Vida® directory under ‘Examples\Mxke 17

About MIKE 11 and MOUSE Result Files

MIKE 11 and MOUSE produce several types of result files which all have one thing in common:
they contain time series for various variables in the system.

The result files from the two types of models are distinguished by the file extenston. Each result file

type can contain only certain types of time series, which depends on the actual process treated by
the model (e.g. runoff, sewer network flow, river flow, pollution transport, etc.).

8-2 DH! Water & Environment
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From the MIKE View point of view, the result files are hierarchically divided in two groups:
e Files including. the network geographical information: '

e MIKE 11 DSF result file (*RES11), .

e MOUSE HD result file (PRF)

e MIKE 11 HD result file RRF), MIKE 11 version 3.2 and previous versions — and not to be
confused with MOUSE Runoff result files which also has the extension RRF but cannot be
opened, only added '

e Files without the network geographical files, e.g. Advection-Dispersion result file generated with
MIKE 11 version 3.2 or previous releases (TRF).

The files from the first group establish a platform for the result viewing in MIKE View, since MIKE
View is a map-based presentation tool These files can be loaded into MIKE View through the
<Open> function. )

The files from the second group can be loaded into MIKE View with the <Add> function; being
associated with the relevant (already loaded) file from the first group. Of course, the added file has
to be fully consistent with its associated MIKE 11 or MOUSE file.

What Are We Going to View

The river network related to the result file in this tutorial consists of the following elements:

e 10 River branches including one main river and several tributaries feeding the main stream,
¢ 8 hydraulic structures of which 7 are regular broad-crested weirs and one is a controllable *

structure with a movable gate controlled by the water-level conditions in a gauging point
upstream of the movable gate.

We are going to examine the details of the network layout throughout the exercise.

Loading Results )

Start MIKE View by choosing ‘MIKE View’ in the ‘MIKE 11’ program group.

At start-up, MIKE View opens the File Open view. This facility makes it possible to navigate
through the accessible drives, and you can easily find the data directory with your result file.

Examine the possible choices of result file types by clicking on the ‘Files of Type’ field. Select the
‘MIKE 11 DFS Files (*Res11)’ option, i.e. the MIKE 11 4.xx Result file.

All DES11-files available in the Vida directory are listed. Select the VIDA96-3.Res11’ file.

Some result files can be rather large, being hard work even for a fast PC. It is often sufficient to load
the data from a result file selectively, so that your hardware is used in a more rational way. MIKE
View gives you a chance to discard the unnecessary data types or irrelevant simulation periods, or to
reduce the level of time resolution of the displayed data. You simply switch ON or OFF certain data
types, redefine the time interval for loading, and select the appropriate step-loading factor.
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Figure 8.1: The Data Load Selection View. As default, MIKE Viiew proposes the complete result
Sile to be loaded.

The tutorial result file is fairly small, and you should simply confirm the default selection by clicking
on the <OK> button. After a short while, the file is loaded and MIKE View opens two new .
windows. .

8.8 Exploring the MIKE View Screen

MIKE View has opened two windows:
Horizontal Plan window

Plan Overview window

Please note: . :
If your MIKE View ‘remembers’ some other settings from the previous session, the Palette window
may also be on the screen, and the Horizontal Plan will be coloured. :

The Horizontal Plan window dominates MIKE View. It displays the layout of the sewer network. If
you select the Horizontal Plan window it becomes the active window, and the Horizontal Plan
toolbar appears under the main menu. ' ‘

When you move the cursor within the Horizontal Plan window; the co-ordinates of the current
position are displayed in the status bar, located in the bottom left corner. The status bar also -
provides useful information on the program mode, help text, etc.

The Overview Plan window contains an outline of the network Horizontal Plan. It makes it easier to

see where in the network you are while zooming. Try to arrange the size and position of the MIKE m=

View windows, until you get them in a desired layout. e
b
s
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8.9 Viewing System Data

The best way to get a closer look at the Horizontal Plan is through playing with the various options
available.

The Horizontal Plan Options View is activated by clicking on'the Options tool in the toolbar, or by
activating the Horizontal Plan local menu (press the right mouse button, while in the window).

| Symubok'and Fonis'

Figure 8.2: Horizontal Plan Options View

Let’s first try to understand the modelled network. The various options available in MIKE View
have been designed exactly to facilitate this activity.

Try the different options from the Plan Type group. Select one of the drawing modes featuring the
system information, e.g. by selecting ‘Slope’. This may give you a first impression of the
topographical layout of the network: the slopes of the links will be displayed as a palette of colours.
Furthermore, you may select ‘Slope’ under the ‘Symbols and Fonts’ group, which will add arrows to
the links, indicating the direction of the slopes (works only if ‘Slope’ has been selected under ‘Plan
Type)). Similarly, if you select ‘Bottom Levels’, the colour palette will illustrate the bottom level of
the Riverbed. :

Under the ‘Symbols and Fonts’ group, you may adjust the size of symbols and the thickness of links
and select your preferred font type and size.

Further, the system can be explored by sélecting and viewing the longitudinal profiles along various
selected paths.’ :
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Figure 8.3: The network plan plot.

Zooming

The zoom function is available in all of the MIKE View graphical presentation windows. It is
activated by choosing the various zoom tools in the toolbar, or by selecting <Zoom In>, <Zoom
Out> or <Zoom Previous> in the local menu.

If you choose “Zoom In’ the cursor changes to a magnifying glass symbol. Move it to the location
on the plan plot, which should be one of the corners of the zoomed-in frame. Then press the mouse
button and drag the cursor across the Horizontal Plan. The cursor has again changed shape, and the
zoom frame rectangle indicates the area, which will be included into the zoomed Horizontal Plan
window. Continue the dragging until you are satisfied with the area included. Release the mouse
button, and the displayed part of the network Horizontal Plan reduces to the framed area only.

The scroll bars of the Horizontal Plan window make it possible to ‘pan’ the zoomed frame over the
network area. Also, you can drag the zoom frame rectangle in the Overview window over the
network area to the desired position.

If you would like to see the whole network again, use <Zoom Out> or <Zoom Previous>

Viewing Results

Selecting result variable and plot type .

Under the Horizontal Plan <Options><Plan Type> select one of the result variables. You may
notice that the result variables are divided into two groups: some vanables are attached to network
nodes, and others are attached to links. -

At first, if you have more than one result file loaded into MIKE View, you should select the desired
file. Then, you select a desired variable from the list of the available variables.
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Fmally, you select 2 mode for the presentation. The results may be viewed as animation, as
minimum results or as maximum results. Selection of ‘Min’ or ‘Max’ results in the lower or upper
envelope for the selected variable being displayed as static Horizontal Plan plot. If you select
Animation, then the selected variable will be displayed dvnarmcally, as a replay of the simulation
through time. We will choose the animation.

The only file available (i.e. loaded in MIKE View) is the TUTOR1.PRF. Choose the group of
variables related to links, and select ‘Discharge Branches’ (i.e. Links). Check if ‘Amrnatlon 1s
selected as the plot type.

When you are finished click <OK>. MIKE View now displays the discharges in the Horizontal
Plan; corresponding to the start time of the simulation.

Note the date and time indicator in the upper part of the Honzontal Plan (the ‘Clock’). The ‘tape
recorder’ buttons in the toolbar have been activated, too.

Animation in the horizontal plan
If you click on the run button, the animation will start. You may notice that the time elapses in the
Clocl-.’ and that the colours on the plan plot are changmg, following the dlscharge dynamics.

Try the other animation functions: Pause Stop, Step Forwa.rd and Step Backward. The funcuonahty
is the same as controlling a tape recorder.

Under the Main menu <Animation><Advanced>, you can adjust the speed of the animation and
some other parameters. Try and see the difference.

Flooding and depth

MIKE 11 computes absolute water levels. However, it may be of a particular interest to see where
flooding occurs in the system. MIKE View can compute the flooding as 2 new variable, which you
can view as any other result variable.

In the Main menu choose <Tools><Compute><Flood>. As soon as you click with the mouse, the
flooding is computed for the whole system, and added on the list of the available variables (in the
Options View).

Go back to the Horzontal Plan window and select ‘Flood’ in links under <Options> of the local
menu. Change the plan type to ‘Max’ and click <OK>. Your Horizontal Plan now displays the
upper envelope of the flooding, which occurred during the simulated event. You can also view the
dynamics of the flooding, simply by switching to the plot type ‘Animation’ and pressing the ‘run’
tool.

Additionally, the actual water depth of a certain location can be of interest. Cornpute also depth in
the systemn. Show these variables as ‘Max’ and as ‘Ammauon see Figure 8.4.
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Figure 8.4: Maxamum Depth for the simulated event.

Adjusting Min/Max range and colour palette :

In reality, you are not interested in seeing the ‘negative’ flooding displayed, i.e. the situation where
the water levels are contained within the surface levels as specified in the MIKE 11 model. This
problem can be easily solved, by adjusting the ‘Min’ and ‘Max’ of the displayed range.

Activate the' <Change Palette Intervals> function in the Horizontal Plan local menu, and change the

‘Min’ to zero. You may also change the ‘Max’ value to be some round number. Confirm your
settings and have a look at the plan plot: Initially, the whole network is grey, indicating that there is
no flooding. When you start the simulation, only those parts of the system where the flooding
actually occurs changes colours, according to the palette.

The palette may be controlled in many ways. Click the right mouse button while in the palette -
window, and examine the possibilities.

If you do not like the colours on the palette, you may change them with the palette editor. Just

double-click on the colout you want to change, and the editor opens. Similarly, if the range intervals

are not suitable for your presentation, double click on the value, which you want to edit.

It is recommended that you spend some time playing with the palette. It will pay-off when you can
efficiently apply your new experience in future work. Moreover, if you create a custom palette of a
more general applicability, or if you want to have it at hand next time you work with MIKE View,

just save the palette settings into a PAL file. Next time, load it and your own palette will be there

again.
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‘Exporting the horizontal plan
You will often be in a situation, where you want to include some of the MIKE View graphs into
your text report. With MIKE View there is nothing easier.

Of course, your word processor should be a true Windows application with Copy and Paste
facilities, e.g. Word. Start it, and open your report document (or create a new one for the exercise).

Return back to MIKE View, adjust the Horizontal Plan to fit your needs in the report, and activate
the local menu. Simply click on the <Copy Graphics > option. Apparently, nothing happens, but
actually, the content of your Horizontal Plan has been copied to the Windows Clipboard.

Switch again to the text editor, position the cursor at the desired location, and activate the standard
<Edit><Paste> function. The MIKE View plot is pasted into your document as a fully vectorised
graphical image, which opens the possibilities for resizing and editing.

This facility works for any graphical window in MIKE View.

' Viewing Results in a Longitudinal Profile

The Horizontal Plan is the working area where items may be selected for all the other presentation
modes: longitudinal profile, time series, Q-H relations and Cross-section animations.

Selecting a longitudinal profile
Let’s assume that we want to have a look at the longitudinal profile of the main stream starting from
upstream point and down to the boundary point where the diver has its connection with the sea.

1] gy il

Click on the Longitudinal Profile tool in the toolbar 22} and point with the cursor in the vicinity of
the upstream point of VIDAA-OVR (ch 108 m). When the cursor changes to an arrow, it means
that you can start the selection of the longitudinal profile.

Click on the branch, and the VIDAA-OVR branch changes colour to green. Continue the selection
by clicking at each branch (or in the direction) along the desired path. MIKE View paints your
selections bold green. When you arrive to the last branch, MIKE View recognises the end of the
path and proposes that the selection is closed. Confirm and choose the type of variable, which you
would like to show in the longitudinal profile. The default selection is “Water Levels’.

Note:
If you have selected a wrong branch, ‘deselect’ the last selected branch by clicking on the mouse
button and pressing the Shift key at the same time (or simply press Backspace). '

Animating a longitudinal profile ‘

At first, resize and reposition the Longitudinal Profile window, until you are satisfied with the
appearance. You can also, as in the Horizontal Plan, zoom-in, zoom-out and control various display
options by opening the Options View from the local menu.

The animation is started in exactly the same way as in the Horizontal Plan: Just click on the ‘Run’
tool in the toolbar.

Synchronising animations

If you want, the animation in two or more windows can be fully synchronised. This means that the
animation in each of the open Horizontal Plan and Longitudinal Profile windows will elapse
synchronously and that you can follow the system dynamics from several ‘angles’ simultaneously.

S
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8.12

You can only have one Horizontal Plan window opened with each of the result files loaded. But, if
you load more result files (e.g. one from MIKE 11 and the other from MOUSE or two MIKE 11
result files), a synchronised animation can be made also for two Horizontal Plan windows.

To make sure that your windows are ‘synchronised’ select <Animation><Synchronize All Plots>.
Next time you start the animation, all windows will be in motion.

Each of the windows can individually be excluded from the synchronised animation. This switch is
available under the local menu of the window.

Viewing Time Series

Time series graphs are usually the most relevant graphs for the system analyses. MIKE View allows
you to see any of the existing time series from the loaded result files, to view them in combination
with the measured data, and to create time series graphs with all possible time series combinations.

Selecting a time series

Let’s assume that the water level is of our primary interest. Click the &% button; ‘Select Gndpoint’
in the toolbar and select “Water Level as the variable. Select the RES11 file (in case you have
multiple files added to the current project), and either point the cursor to a point in the horizontal
plan or press the List’ button to select the Time series location from a table. Please note, that if you '
selects the point from the plan plot, you are kept informed in the info bar (lower left corner of the
MIKEView window) on which point you are actually pointing at.

The cursor changes to an arrow if you are pointing at a point equal to the item you have just selected
(= Water level) indicating that here data are available After clicking with the mouse, MIKE View
opens a window with a graph showing the Water level for the actual point.

Try also to select a Time Series from the Time Sertes List selection window.

Similarly, as in the longitudinal profile window, you can control the appearance of this window in
many ways with the right mouse pop-up menu. Try to open the ‘TS Settings. ..’ under ‘Options’ in
the pop-up menu. Here, you can change the thickness, colours and other settings for appearance of
individual series in the actual window. '

Adding items to a time series graph

You can complement any time series graph with as many other time series of the same data type as
you wish (e.g. Water Level). Additionally, you can add data of a different data type to the same
windows — max 2 data type area allowed within a2 Time Series window. These may come from the
same result file, from some other loaded result file, from a separate DFSO-file, from the MIKE
11/MOUSE time series databases, from the Cl.ipboard or from a text file.

- Just for the exercise, let’s view the water level in a specific point in combination thh a dlscharge

time series from an external DFSO0-file.

Press the Time Series tool button, select “Water Level’ and press the List button. In the list of
calculation points go down to the point VIDAA-OVR 4822.00 and select this point by activating
the check mark in the first column. Press the ‘Draw Graph’ button to draw the Time Series in 2 new
Windows. After this, open the right mouse pop-up menu and choose <External TS>, in order to
open the External Time Series View.

8-10 DHI Water & Environment
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Figure 8.5: The External Time Series View.

Click on the <Load DFS0> button and find the file; M4234-Q.DFS0. Select the file and MIKE
View are loading the time series, which can then be used for comparison with the simulated series

In order to get the time series displayed in the graph, you should select it by clicking with the mouse
on the time series identifier. Before confirming your selection with <OK>, select ‘Use second y-
axis’ from the list. This will cause the Water level and the discharge to be shown with each their y-
axis.
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9.1

9.2

Demo Set-up included in the DHI CD-Rom

Introduction_

Setting up 2 river model — especially for new users of MIKE 11 — typically introduces some initial
problems on how to schematise the natural river in the mathematical model, which input data are
required, how to combine the measured series of hydrometric data and topographical surveys etc.
etc. To reduce the amount of initial difficulties in the process of setting up a river model for the first
time, it is often beneficial to obtain experience from already existing river set-ups.

Included in the MIKE 11 installation, you will find two examples of river model set-ups including all
required data input files to perform a Hydrodynamic simulation with MIKE 11. The two examples
comprises a set-up for a Danish stream (small river) named “Vida’ and a reduced set-up for a river in
Bangladesh named ‘Cali’.

Input files for the demonstration 'set-ups are aufométically irlst‘alled to your computer when
installing MIKE 11. Input data comprises files for the River Network, Cross-sections (River
topography), Boundary definitions, hydrometric time sertes data and HD parameters.

After installing MIKE 11, the demonstration set-ups are located in the directories:
‘...\MIKEZero\Examples\Mike_11\Vida’ (Vida Stream)
‘. .\IvﬁKEZero\Examples\Mike_l 1\Demo’ (Cali River)

How to Use the Demonstration Set-ups

A source of inspiration for own projects, or an exercise for inexperienced users to familiarise
themselves with the various editor features and functions of MIKE 11. This could be some of the
achievements for users when examining and working with the enclosed demonstration set-ups from
the CD-Rom. '

MIKE 11 works both as a2 Demo version (without a software key and valid hicense files) and as a
Full version (with software key and valid license files). If MIKE 11 works as Demo version, several
limitations apply compared to the Full version. All editors are accessible and operate as in a full
version, but restrictions apply for the number of data objects allowed when saving editor data files.

Limitations for 2 Demo version are: .

-. max 50 grid points in the niver set-up, .
- max 3 niver branches, ‘ :

- max 1 hydraulic structure,

- max 1 Q/h boundary,

- max 1 NAM catchment,

- max 10 cross-sections,

- max 3 time series items containing max 50 time steps

: Thé enclosed two set-ups differ from each other primarily by the number of data objects included in

the set-up;
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9.3

The Cali river set-up has been reduced from the original size in order to compixise the limitations of
the MIKE 11 Demo version. It is therefore possible to modify and save input data, perform
simulations and view results from simulations which means, that also users working with the Demo
version can use the Cali set-up as an exercise to familiarise themselves with MIKE 11 and eventually
make a set of ‘what-if’ scenarios. _

E.g. what happens if I change the Manning number globally? What happens if I change the
boundary conditions? What happens if I change the shape of cross-sections? etc. etc.

The Vida river set-up comprises a fully, non-reduced river set-up. The amount of data and number
of data objects significantly exceeds the limitations of MIKE 11 Demo version, and therefore, it is
not possible modify and save the content of the data files in the Vida set-up if you are working with
the Demo version. In this case, it is only possible to open the data files, view the content and obtain
knowledge on how the river system is defined — the date files can not be re-saved due to the large
amount of data.

Cali River

The enclosed Cali River set-up has been modified to reduce the original number of input elements
(cross-sections and river branches) to keep within the limitations of MIKE 11 Demo version.-

The set-up comprises 3 river branches and 10 cross-sections. The boundaries consist of a single
recorded upstream inflow and two downstream water levels conditions. A plan plot of the Cali River
set-up is presented in Figure 9.1.
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Figure 9.1:  Cali River, plan plot of MIKE 11 set-up
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files are all located in the *.. \Ezamples\Mike_11\Demo’ directory. To load the files select File
Open (Ctrl+0), change directory to Examples\Mike_11\Demo in the File selection box and select
the file type you wish to load (e.g. Time series file, simulation file, network file etc.).

When integrating information from the pre-defined editor files, you should initially open the
simulation editor file (Cali.Sim11). Select the ‘Input’ property page and open a specific editor by
pressing the ‘Edit...” button.

Please note that two boundary files are enclosed. The two files illustrate two different methods for
defining boundary conditions (i.e. by extracting time series items from either one or several Time
series files).

1) “CALI1.BND11™: o
The three boundary conditions are defined by extracting time series items from three different
Time series files (*.Dfs0). Each time series file contains only one item.

2) “CALIZBND11”: .
The three bouhdary conditions are defined by extracting time series items from only one Time
series file. The current Time series file contains three items. .

Using the pre-defined settings in the Simulition editor for input files the simulation period and time
step, it is possible to perform a simulation and view the results in the result presentation
programme, MIKE View. ’

Vida

The second example is a set-up from a stream (small river) in Denmark, named ‘Vid-A’. The set-up
was developed by DHI for 2 project conducted in 1997.

- The Vida set-up comprises a main river branch with several smaller tributaries feeding into the main
river. Boundary conditions are defined as inflow hydrographs on all upstream boundaries and a
downstream tidal boundary at the sea. The downstream boundary is defined by applying measured

3

water levels covering a large number of tidal periods. §

Input files for the Vida set-up are located in ‘... \Examples\Mike_11\Vida’. All input files required
to perform the hydrodynamic computation are present. Additionally, two graphical files (GIF) are
enclosed each containing a scanned map of the study area. The scanned images are provided as high
and low resolution (200 dpi or 400 dpi). :
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Figure 9.2: Vida, plan plot of MIKE 11 set-up including background map
TSJ, May 2000
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